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1.  Introduction

InPort Overview
The FIS InPort Catalog gives NOAA Fisheries and its state and regional part-
ners the capability to share essential information about fisheries data.  InPort 
stores metadata, information about data. InPort, for example, can help answer 
the following questions: 

•	 What logbook data exist for US fisheries? 
•	 What time periods and geographic areas are covered by the logbook 

records? 
•	 Who controls the data and how do I contact that individual or 

organization?
InPort (Information Portal) is one of the initial, bootstrap systems planned 
for the National Fisheries Information System (FIS) to give NOAA Fisheries 
and its partners the capability to catalog and search fisheries data holdings. The 
InPort data catalog can contain the information needed to understand and use 
fisheries data. InPort does not store fisheries data itself.

InPort will store metadata, information about data.  This will include descrip-
tions of structure and content. InPort will not, however, store any of the data. For 
example, it might say that SEFSC has logbook data from 1986 to the present 
and describe tables and column descriptions. But InPort will not store the log-
book data. In InPort, metadata includes information that helps explain what is in 
the data and how to use the data.

InPort should include the “what, where, when, how, and who” about data hold-
ings.  InPort should store details on the quality and completeness of data, its 
confidentiality policies, research models, methodologies and usage constraints. It 
should also explain if the data is accessible, if there are any constraints on its use, 
and who to contact about getting the data.

InPort should function much like a library card catalog. A card catalog describes 
each book in the library by title, author, publisher, and publication date. It also 
contains a reference number to locate the book among the book shelves. By 
comparison, InPort should have titles, authors, publishing organizations, publica-
tion dates, and whom to contact if you wanted to use the information. InPort 
will also contain other details about the structure of the data.

InPort was originally described in 2003 and was funded in May 2004 under the 
FIS Program.  See Appendix D for more information on FIS.

  |   1



InPort Support 

The initial roll-out of InPort, the database, web servers, and support staff will be 
at the NOAA Fisheries Service, Pacific Islands Fisheries Science Center.  InPort 
will reside at the NOAA Fisheries, Office of Science and Technology in Silver 
Spring, MD.

Reporting Issues

Reporting of issues, comments, and ideas for improving InPort are greatly 
encouraged.  An e-mail link to the InPort team can be found at the bottom of 
the InPort web pages and this document.  The design of InPort has been a col-
laborative effort within the National Fisheries Information System Program and 
additional comments and feedback will ensure that our Fisheries partners benefit 
from its use.

Technical Support

For technical assistance on InPort tools, web site or browser technical problems, 
or for obtaining your account password, please contact InPort Support at:

•	 Tel:	 305.361.4287
•	 E-mail:	 lee.weinberger@noaa.gov

Using the InPort User Guide

This user guide is designed to work well either in print or online.  We suggest 
that since it is rather large and the InPort team is committed to responding 
to requests for corrections and additions that it is best used as an online tool.  
Bookmarks in the online view will aid in navigating through the document.  
Multiple tables of content (text, figures, instructions), an index, along with the 
ability to word search should allow users to quickly locate the information they 
seek.

User Guide Conventions
•	 Command - as selected from menu lists
•	 Example Data - as used in tutorials
•	 Field Data - as entered into field items
•	 Field Name - as described in an InPort tool/application
•	 Form Element - as named in an InPort tool/application
•	 FORM NAME - as a named InPort tool/application
•	 Glossary Term - as listed in the glossary in the appendix
•	 Web link - showing a url address

Metadata Assistance

There are a multitude of resources on how to document data and we include 
some of those references in Appendix B. Please note that most metadata tutori-
als focus on documenting data end products such as maps, images, reports, and 
data download files.  While InPort was designed to facilitate the generation of 
FGDC metadata records which can be submitted to metadata repositories such 
as the Coral Reef Information System (CoRIS) and the FGDC Geospatial Data 
Clearinghouse, InPort is focused on managing information about the entire 
life-cycle of our data collections, from which many data products are produced 

2	 |  Introduction
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and distributed with its appropriately formatted metadata record.  That metadata 
record will most typically be in FGDC, NASA, or Dublin Core format.

InPort Functions
InPort is described as a data catalog which holds descriptions of fisheries related 
data. For example:

•	 Pacific Islands logbook data, 1990 to present
•	 Southeast Region landings data, 1960 to present
•	 N and S Pacific Albacore Troll and Bait Boat (1952 to present) 

The InPort catalog is comprised of multiple individual Metadata Libraries.  A 
Metadata Library is associated with one organization though the Organiza-
tion-Library pair may have sub-organizations under them.  Libraries contain 
details about an organization’s information items, including projects, data sets 
(databases), and data entities (e.g., tables, files, data reports, etc.), documents, 
and procedures. Each item in the Library hierarchy is called a Catalog Item.  The 
Library itself can be thought of as the root-node or base of the hierarchy. 

The InPort Catalog also maintains information about the people and organi-
zations that support the individual information items, called Catalog Items, 
being cataloged and as InPort Users and Organizations that support the InPort 
Catalog system.

Catalog Items may be described in more detail by standard, descriptive modules 
called Detail Modules (e.g., time frames, geographic areas, attributes, etc.).

The InPort system maintains functions for administration of InPort persons 
and organizations and for the maintenance, searching, and extracting of catalog 
metadata.

1.1. InPort Functional Areas

Catalog Maintenance

Enter, validate, review, edit
catalog items

Publish and/or withdraw catalog
items

Move catalog items within the
catalog hierarchy

Catalog Administration

Register Organizations and
Persons, create Libraries,
Process InPort User Role
requests, authorizations, and
rejections

Catalog Searching

Web Site

Published
Catalog
Items

Catalog Extraction

XML exports to metadata
consumers

Catalog Administration

InPort Catalog Administration includes those tasks performed by the InPort 
Administrator to create Metadata Libraries, manage Metadata Librarians as-
signed to each Library, and manage reference code lists that support the Catalog.  
The InPort Administrator also defines the publication workflow and catalog 
hierarchy rules.

Library Administration includes those tasks performed by the Metadata Li-



brarians to process new InPort users and user accounts for their InPort Library.  
Librarians are also responsible for maintaining a high level of quality and consis-
tency in cataloging and describing their organization’s information items.

Catalog Maintenance

InPort Catalog Maintenance includes those tasks performed by a Library’s 
Librarians, Authors, Publishers, and Readers to enter, validate, review, edit, and 
approve the metadata for Catalog Items.  Catalog Items may also be moved 
within a catalog hierarchy, depending on the item’s publication workflow state 
(e.g., an item cannot be moved if it is currently published).

Catalog Publication

InPort currently supports three levels of Publication of Catalog Items:

1.	 Unpublished but accessible to the item’s Library users through 
the InPort tools.

2.	 Published (Internally) and InPort web accessible only to the 
InPort user community (i.e., requires login).

3.	 Published (Externally) and InPort web accessible to the public 
(no login required).

Catalog Extractions

Besides the main function of InPort to maintain complete details and history 
of an organization’s information items, metadata in InPort will be extracted 
to support web portals, metadata servers, and other metadata consumers.  This 
approach will ensure that metadata is maintained in a single repository and that 
metadata extractions will provide the most currently published information 
about the information items of interest.

InPort Catalog Content
Each Catalog Item is significant as metadata information needed to describe an 
information item.  There are many different Catalog Item types.

•	 Metadata Library(*)
•	 Project
•	 Data Set 
•	 Data Collection Item
•	 Data Entity
•	 Document
•	 Procedure

See InPort Glossary for definitions or refer to the Catalog Maintenance section 
of this user guide for details on each catalog item type.

(*) The Metadata Library is a special Catalog Item that represents all the cur-
rently cataloged data collection activities of an Organization.

•	 Each organization may have one and only one Metadata Library.
•	 All the metadata for an organization is arranged under its Metadata 

Library hierarchy
•	 Metadata Libraries are root catalog items for catalog hierarchy trees
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Catalog Hierarchy
Catalog items may be organized in a hierarchy according to the following rules:

•	 Each catalog item may belong to one-and-only-one parent catalog 
item

•	 Each catalog item may be the parent of one or more catalog items
•	 Each catalog item may not be the parent of itself

Figure 1.2 shows an example of a Catalog Hierarchy.  This represents a small 
branch within a single InPort metadata library.  This hierarchical organization 
of metadata allows metadata producers and consumers to publish and/or search 
for metadata from a high-level data-discovery mode and drill down to a very 
detailed data specification level.  InPort’s hierarchical and modular design also 
allows data managers to document their data collections as the information 
becomes available rather than having to wait until all information is gathered.

1.2.  InPort Catalog Hierarchy

Hawaii Longline
Observer
Program

LODS
(Data System)

Trips
(Database Table)

Set of Data
Collection Forms

Fish Length
Measurement

Trip_Specificatio
n.pdf

LODS
(Database)

Trip Num
(Column)

Observer ID
(Column)

Fish
Measurement

Protocol

Set of Data
Collection Items

PIFSC Metadata
Library

Sea Surface
Temperature

Sea Surface
Temp. Method

The InPort Catalog organizes Catalog Items in a hierarchy.



InPort User Roles and Responsibilities
In its current configuration, InPort supports three types of users to administer 
the InPort system and Libraries and three types of users for publishing items in 
the catalog.

1.3.  InPort User Roles

InPort Metadata Catalog

Metadata Library

Pacific Islands Fisheries Science Center

InPort System Administrator

Karen Sender
PIFSC
808-983-5387

(Note that in 2006, InPort will 
be maintained at NOAA
Fisheries ST Office

Metadata Librarian

Noah Webster

Metadata Author

Pacific Islands Fisheries
Science Center

Metadata Reader

Pacific Islands Fisheries
Science Center

Metadata Publisher

Pacific Islands Fisheries
Science Center

Metadata Publisher

Rowland Harper

Metadata Author

Pacific Islands Fisheries
Science Center

Metadata Author

Pacific Islands Fisheries
Science Center

Metadata Author

James Michener

Metadata Reader

Pacific Islands Fisheries
Science Center

Metadata Reader

Pacific Islands Fisheries
Science Center

Metadata Reader

Big Bird

Data Steward

Dana Steward

There are currently six separate User Roles in InPort.  These User Roles ensure that 
InPort users have access and editing capabilities that are granted and managed by 
the local InPort Librarians.

InPort User Roles for Administration

InPort Administrators

InPort Administrators have sole authority to define and maintain Publication 
Workflow (control states), InPort User Roles, and  manage reference codes.

It is the InPort Administrator who can create Master (root-level) Organizations 
and their InPort Metadata Libraries, and create and manage their Librarian and 
Data Steward accounts.  
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InPort Librarians

An InPort Librarian can create and manage catalog Persons and InPort user 
accounts for their Metadata Library.  Librarians can create and manage catalog 
project User Role requests, authorizations and rejections.

Librarians create new organizations under their Organization and can create and 
manage catalog project folders under their Metadata Library.

InPort Data Stewards

InPort Data Stewards have the same catalog privileges as an InPort Reader but 
have the ultimate responsibility of authorizing or rejecting InPort User Roles.

InPort User Roles for Publishing

InPort Publishers

InPort Publishers manage the review of metadata and ensure that quality as-
surance processes are completed.  Publishers should give feedback and advice to 
InPort Authors on metadata quality and sufficiency.

Publishers are responsible for web publication, either internally or externally, and 
for withdrawing metadata for correction or further review.  Publishers will moni-
tor metadata issues activity and ensure that issues resolution occurs in a timely 
fashion.

InPort Authors

InPort Authors enter, review, and correct metadata that is in a Draft state in 
the Library or catalog Project for which they have been granted an Author role.  
Authors have authority to put metadata into Review/Revise state at which point 
the Author will no longer have edit capabilities.  Authors are responsible for 
requesting publication review for that metadata from their Catalog Publisher. 

InPort Readers

InPort Readers review catalog items through the Catalog Editor or log onto the 
InPort web site to search and view internally published catalog items.  Readers 
do not have any edit abilities.  Readers are responsible for reporting any meta-
data issues.

Metadata Quality Controls
Every effort is made to ensure that metadata for all Catalog Items is of the high-
est quality.  Measures taken in this regard include:

•	 Audit fields for each metadata record which show who and when 
metadata records were created or modified

•	 Record and field item history tracking
•	 Tightly controlled metadata approval and publication process (work-

flow control) that is dependent upon InPort User Roles
•	 Metadata cannot be edited either in Approved or Published state 
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without first being Withdrawn from publication and/or being placed 
back in Review/Revise state.

•	 Metadata Review Date support to enforce annual review of meta-
data for continued publication.
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2.  Getting Started

System Requirements
Users will need to access InPort applications with one of the following internet 
browsers:

•	 Internet Exploror 7.0 (with Windows XP/Vista/Windows 7)
•	 Mozilla Firefox
•	 Google Chrome



Accessing the InPort Web Site
https://ias.pifsc.noaa.gov/inport

2.1  InPort Home Page

The InPort Home Page is publicly accessible for searching externally published 
metadata and for finding out information about the InPort system.

The InPort home page displays the current message of the day and the InPort 
Search text box.  There is also a link for InPort User login and other links for ac-
cessing more information about InPort.

It is not necessary to have an InPort user account to search for catalog items that 
are published to the public (in InPort terms, Published-Externally).  However, 
to search for catalog items that have restricted publication (in InPort terms, 
Published-Internally), a user login with an InPort username and password, is 
required.  After logging in, an InPort search will return all published (Internally 
or Externally) catalog items.  Logging in to InPort will also make the various 
InPort Catalog tools available to the user.

10	 |  Getting Started
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2.2  InPort Login Page

Registered InPort users need to log into the InPort web site in order to access the 
tools for creating, managing and publishing metadata.  Users do not need to log in 
to search publically (externally) published metadata.

How to Log into the InPort Web Site

1.	 Click the login link in the upper right-hand corner of the 
InPort home page

2.	 Enter your InPort username and password (if you do not have 
an InPort user account, you may contact the InPort Adminis-
trator to obtain one.

3.	 Click the Login button.  This will open up the InPort Publishing 
page



2.3  InPort Publishing Page

The InPort Publishing Page provides links to the tools for creating, managing, and 
publishing metadata.

2.4  InPort Account Management Page

InPort users can change their login password from the InPort Account Manage-
ment page which is available after logging in to the web site.  InPort Librarians can 
also manage their user’s InPort accounts using the Library Manager tool.
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Accessing InPort Applications
Clicking on the InPort Catalog Tools link on the InPort Publishing page will 
display the application’s login screen. The InPort user will be required to enter 
his/her username and password even though they have already logged into the 
InPort web site.  

2.5  InPort Catalog Tools Login Screen

Even though the user has already logged in to the InPort web site, the user must 
also log in to the InPort Catalog Tools.

InPort Catalog Tools Menu

After entering a valid username and password, the InPort Catalog Tools menu 
will provide access to the applications to which the current user has authorized 
access.  An InPort Librarian will have more tools available than an InPort Au-
thor, who in turn will have more tools than an InPort Reader.



2.6  InPort Catalog Tools Menu Screen

The InPort Catalog Tools Menu is sensitive to the User Role of the currently 
logged in user and will thus only allow access to the tools appropriate for that user.

InPort Application Screens
2.7  Example of an InPort  Application Screen (Catalog Editor)

InPort applications try to have a consistent look-and-feel and layout to help the 
user understand the tools.

Application Layouts
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Header

2.8  Application Headers

The right side of the application Header pane will show the names and titles of the 
objects in the Editor pane.  Information on the left side of the Header pane shows 
the current application, current user, publishing state of the item, date and time the 
user logged in to the application and the database and server names.

Editor Pane

2.9  Example of an InPort Application Editor Pane - Catalog Editor

The application Editor pane shows the information for the currently selected 
object in the Navigator pane.  Note that the many tab screens are made available 
dynamically according to the rules for the specific type of item that is selected in 
the Navigator pane.



Navigator Pane

2.10  Example of an InPort Application Navigator Pane - Catalog Editor

Navigation trees allow users to drill up and down to locate information.  The 
detailed information for the currently selected item is displayed in the Editor Pane. 
The Search text box and the Find Next button allows the user to search for the next 
occurrence of an item that matches the search string text.

Selecting a Tree-Node

Click on the item name in the Navigator pane to select that item.  If the item 
name is not highlighted - then it has not been selected.  The information for the 
highlighted item is displayed in the Editor pane.

Expanding/Collapsing a Tree-Node

Tree nodes can be expanded to view their child items by either double clicking 
on the item in the Navigator pane or by clicking on the + before the item’s name.

Searching the Tree

Enter a text string in the Search box and click on the Find button in the Naviga-
tor pane to find the next item in the tree that matches that search string.  The 
user may continue to click on the Find button to search further down the tree.  If 
no other matches are found, then the search will start back at the top of the tree.
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Application Help
2.11  Application Help Functions

InPort applications provide multiple modes for accessing helpful information 
about the applications, including screen help, field item help and configurable 
tool-tips.

Tab Screen Help

Application screen help is accessible via a fly-out menu.  Right-click anywhere 
in the canvas area - outside a field item - and select either Navigator Help or 
Editor Help. The Editor Help option is context sensitive and returns help infor-
mation for the currently selected tab in the Editor pane.



2.12  Tab Screen Help

Selecting the Editor Help menu option will display information about the cur-
rently selected tab screen along with details about all the items on that screen.

Field Item Help

Help information for a specific item in the Editor pane is available by clicking 
inside a field item and then clicking on the Help button in the Header bar, typing 
CTRL-H, or from the top menu bar Help > Field Item Help.  Remember to 
dismiss the Help text box in order to continue by clicking the Close button or 
pressing the Spacebar.
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2.13  Field Item Help

Selecting a field item and then clicking on the Help button or selecting the Item 
Help option from the Help menu will display information about the selected field 
item.

Tool Tips

InPort applications start in a mode that enables Tool Tips for fields and buttons.  
These pop-up labels can show the user a short description or instructions for the 
field under the cursor.  The user may use the Preferences menu above the appli-
cation header to disable or reduce the number of items that show tool tips. 



2.14  Field Item Tool tips

Tool tips can be partially or fully disabled through the Preferences menu.

Application Tips

Menus

Right-click on either the Navigator pane or the Editor pane to access functions 
specific to those panes.

List Items

There are two types of list-items fields in InPort applications.  A combo-list al-
lows the user to either enter their own value or, alternatively, select from a list of 
values already used for that field.  The user will see a Ι text bar cursor in this type 
of field. 

The second type of list item, a pop-list, allows the user to select only from a pre-
determined list.  Clicking in this type of field will show an arrow cursor.  Note 
that pop-lists will attempt to do auto-completion if the user types in the first few 
letters of a value that is in the list.  If users find that a pop-list requires another 
option, they should email the InPort development team at inport.devteam@
mail.nmfs.hawaii.edu
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Entering dates and times

Dates and times in InPort are formatted to allow consistency and flexibility to 
the user.  Some fields will allow the user to specify a date/time granualarity, such 
as Y for year or D for year_day.  The format for dates and times in InPort forms 
is as follows…

YYYY-MM-DD  HH:MI 	 (example date: 2004-12-13  00:00)

•	 YYYY 	 is the 4-digit year
•	 MM 	 is the numeric month
•	 DD 	 is the 2-digit day
•	 HH: 	 is the hour (24-hour clock) followed by a colon
•	 MI 	 is the minutes (up to 59)
•	 SSxFF	 decimal seconds
•	 TZH:	 Time zone hour, followed by a colon
•	 TZM	 Time zone minutes (usually 00 but sometimes 30)

Appropriate format hints are displayed in the status bar at bottom of the ap-
plication windows.

Record Details Button

The Record Details button (lower-right on most tab screens) will provide the user 
with the details of who and when the record was created and last modified.  It 
also shows the Catalog Item ID number which is useful when linking to other 
Catalog Items by creating Related Items.

Copying and Pasting From Other Documents

Users may use standard Windows cut-and-paste techniques for text items (Ctrl-
C, Ctrl-V).  The user may cut text from any Windows document and paste it 
into a text field, however, it is best to paste text from word processing applica-
tions into a plain text document (e.g., Notepad), and then copy-paste from there.  
This will ensure that hidden formatting characters are not pasted into the catalog 
field.

Expanding Edit Fields

Text fields are often limited in space.  To open a field editor, press Ctrl-E. Click 
on the Close button to exit the editor and return to the application.



2.15  Expanding Field Items for Editing

Many text fields in InPort can contain far more text then there is room for on the 
screen.  Users can open up the text editor by typing Ctrl-E after clicking into the 
field they want to edit.

Discarding Edits for Individual Fields:  Undo

When editing a data field, a user may wish to abort (undo) the change and revert 
back to the value that was stored in the database (including a NULL value), by 
selecting the Menu Bar>Edit>Undo.  Note that this action will affect only the 
currently selected field item and will only make an obvious change if the current 
edits were not yet saved.  If additional edits need to be discarded, the user can 
click in those fields and select Undo.  It is important to remember that navigat-
ing out of the current tab page will do an automatic Save of any changes.

Closing Pop-up Windows

When messages or warnings are displayed with a pop-up window, the user may 
click on the Close button, press the Space Bar, or press the Enter key to dismiss 
the pop-up window and return to the main application.
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Overview
People and organizations are registered in InPort for two purposes: 1) to manage 
InPort Libraries by serving as Librarian or Owerner Organization, and/or 2) to 
serve in Support Roles for individual catalog items, such as Point-of-Contact or 
Originator.

People and organizations can be registered in InPort by either the InPort Adminis-
trator or, within an individual InPort Library, that Library’s Metadata Librarian.  
Only an InPort Administrator can create InPort Libraries and assign Librarians and 
Data Stewards to a Library.

The Library Manager tool is the main application for catalog administration.  
Additional functions for creating and managing InPort user accounts are acces-
sible through the LIBRARY MANAGER.

InPort Library Setup

How to Create a New InPort Library

1.	 Each organization will identify a Data Steward and Librarian 
(and backups, if desired).

2.	 Complete the InPort Library Request Form (see Appendix D).
3.	 Complete the InPort Person Registration Form (see Appendix 

D) for each Data Steward and Librarian.
4.	 Fax or mail the signed Library Request Form and Person Regis-

tration forms to the InPort Administrator.
5.	 InPort Administrator will set up the new Library and call the 

Librarian with InPort account information.
6.	 The new Library will need one or more people for each of the 

InPort User Roles of Author and Publisher.  The Librarian for 
the new Library may also wish to have other users with Reader 
role for reviewing - rather than editing - privileges.

InPort User Setup
As mentioned above, the roles of Data Steward and Librarian are created by the 
InPort Administrator.  All other InPort Users (Publishers, Authors, Readers) are 
registered and created by the local InPort Librarian(s).
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How to Set Up InPort Users

1.	 If the user does not already exist as an InPort Person, the Meta-
data Librarian creates a new catalog Person using the Library 
Manager tool.

2.	 The InPort Librarian creates a User Role Request for the new 
person using the User Role Manager tool launched through 
the Library Manager.

3.	 The InPort Librarian obtains authorization or rejection from 
the Organization Data Steward.  This is an off-line process at 
the local organization.  The Librarian may use the InPort Per-
son Registration form (see Appendix E).

4.	 The InPort Librarian completes the InPort User Role Request.
5.	 The InPort Librarian creates or modifies the InPort user ac-

count and the database role per the authorized InPort User 
Role Request. 

Library Management

Library Manager Tool Functions

The LIBRARY MANAGER allows InPort Administrators and InPort Librar-
ians to create and manage Organizations, metadata Libraries, and Persons.  An 
InPort Librarian will see the names of all the organizations for which they serve 
as Librarian, in the left hand Navigator pane.  Only InPort Administrators can 
create top (root) level Organizations and Libraries.  The InPort Administrator is 
responsible for creating the Librarian(s) and Data Steward(s) for any organiza-
tion that requires an InPort Library. Librarians may create and manage sub-Or-
ganizations and Persons under their Organizations.
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3.1  InPort Library Manager Tool

The Library Manager is used to register organizations, libraries, and people into 
the InPort system.  InPort Library Manager menus are context sensitive and 
should provide only the functions that are appropriate for the selected tree-node 
type (i.e., organization, library, or person).

The LIBRARY MANAGER also allows InPort administrators and librarians to 
create and process InPort User Roles for InPort persons who will create, manage, 
or publish metadata in their assigned metadata library.  Librarians can also create 
and manage a person’s InPort account from the LIBRARY MANAGER.

LIBRARY MANAGER menus can be accessed by right-clicking inside the 
Navigator pane The menu options are context sensitive and depend both on the 
user’s InPort User Role (Librarian or InPort Administrator) and on the currently 
selected item in the Navigator pane.  The Add Person option will only be available 
when an organization is selected.  The Add Library option will only be available 
when the user is an InPort Administrator and the selected item is an organiza-
tion. 

 The Cut, Copy, Paste options will only be available when a Person is selected. 
Cut with Paste is used to move a person from one organization to another 
and Copy with Paste is used to assign the person to another organization 
without moving them from their home organization.

Selecting an organization, library, or person in the Navigator pane will cause any 
information about the organization, library, or person to appear in the Editor 
pane on the right of the screen.  Selecting an organization item in the Navigator 
pane will display a single Organization tab in the Editor pane.
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Organization Tab

In the Navigator pane, double-click on an Organization name to select and/or 
expand its tree hierarchy. An Organization may contain one and only one 
Library, may contain other Organizations (sub-organizations), and may contain 
an unlimited number of persons.  A given person may appear under multiple 
organizations but will only have one Home Organization where their information 
may be edited.  The asterisk by the person’s status shows that the person record is 
listed under their Home Organization.

How to Add an Organization

1.	 From the INPORT CATALOG TOOLS menu, click on the button 
beside Library Manager to display the Library Manager ap-
plication.

2.	 Select and highlight the appropriate parent Organization 
name in the Navigator pane.

3.	 Right-click and select menu option New Organization.
4.	 In the Editor pane, fill out the Organization’s Details, including 

name, type, address, and contact information, as is available.  
Note that only an InPort Administrator may create a new Root 
(top-level) Organization.  Starred items are required fields.

5.	 Click the Save button.

3.2  Library Manager - Organization Tab

Organization (and sub-organizations) can be documented in the Library Manag-
er’s Organization Tab. 

Screen Item Descriptions

•	 Name - The name of the organization
•	 Acronym - An acronym of the organization
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•	 Type - The selected organization type.
•	 Root Level Organization? - Is this a root org, Y/N? Root organiza-

tions have no parent.  Note that only an InPort Administrator will 
see this item.

•	 Description - A description of the organization
•	 Street Address - The street address of the organization, including 

Suite# or P.O. Box
•	 City - The city where the organization is based
•	 State Province - The state or province where the organization is 

based
•	 Postal Code - The zip or postal code of the organization
•	 Country - The country where the organization is based
•	 Contact Phone - Area code a phone number.  Include country code 

if outside the U.S.
•	 URL - A Universal Resource Locator that can be used to reach the 

organization via the Internet
•	 Business Hours - Business hours, including expected time away.

People, referred to as Persons in InPort, are organized under InPort organiza-
tions.  Organizations can have child Organizations to any level.  Person records 
may be created under any Organization level, however, it is probably most 
practical to create them at the library level.  A Person can be moved from their 
original organization to another organization.  However, unless the current user 
has the Librarian type InPort User Role in both organizations, the move of the 
person would need to be done by the InPort Administrator (who has access to all 
libraries).

Library Tab

InPort Libraries are created under Organizations.  An Organization may contain 
only one library and only the InPort Administrator may create or edit Libraries.

Selecting a Library item in the Navigator pane will display a single Library tab 
in the Editor pane.  Only a minimum amount of information about a Library is 
documented in the LIBRARY MANAGER, however, more complete information 
may be detailed through the INPORT CATALOG EDITOR at any time.

How to Add a Library

•	 From the InPort Catalog Tools menu, click on the button beside 
Library Manager.

•	 Select and highlight the appropriate Organization name in the 
Navigator pane.

•	 Right-click and select menu option New Library.
•	 In the Editor pane, fill out basic information about the Library. 

Starred items are required fields.
•	 Click the Save button. 
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3.3  Library Manager - Library Tab

An InPort Library created and edited in the Library Manager by the InPort 
Administrator, but is viewable by the Librarian.  A Library may be further docu-
mented with the InPort Catalog Editor.

Screen Item Descriptions

•	 Title - Library Title
•	 Abstract - Abstract of the Library
•	 Purpose - Purpose
•	 Supplemental Information and Notes - Supplemental Information 

and Notes

Person Tab

InPort Persons can fulfill two functions within InPort: 

1.	 Serve in an InPort User Role (i.e., Data Steward, Librarian, Pub-
lisher, Author, or Reader)

2.	 Serve in a Support Role to a Catalog Item (e.g., Originator, 
Point-of-Contact).  See the Catalog Editor, Support Roles tab 
for complete documentation.

In both cases, the person must be registered in InPort before either a User Role 
or Support Role can be assigned.

Selecting a Person item in the Navigator pane will display three tabs in the Edi-
tor pane: Person, Assignments, InPort User Roles.  The top Person tab will allow 
detailed documentation of the person’s contact information, employment status, 
expertise, and work location.
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3.4  Library Manager - Person Tab

When a Person is selected in the Navigator pane (or newly created), three tabs will 
be displayed - Person tab, Org. Assignment tab, and InPort User tab.  Details about 
the persons are documented on the Person tab.

How to Register (Add) a Person

1.	 From the INPORT CATALOG TOOLS menu, click on the button 
beside Library Manager.

2.	 Select and highlight the appropriate Organization name in the 
Navigator pane.

3.	 Right-click and select menu option New Person.
4.	 In the Editor pane, fill out the Person’s information for identifi-

cation, contact, work location, employment information, and 
expertise, as is available.  Note that the unique identifier for 
an InPort Person is his/her email address.  Starred items are 
required fields.

5.	 Click the SAVE button.

How to Move a Person to Another Organization

1.	 From the InPort Catalog Tools menu, click on the button be-
side Library Manager.

2.	 Select and highlight the Person’s name and home record in 
the Navigator pane. A person’s home record can be recognized 
by the asterisk before their status, e.g. Dana Steward (*Active). 
Only a person’s home record is edit able.

3.	 Right-click in the Navigator pane and select menu option Cut. 
The Person’s name will appear the Clipboard area below the 
Navigator pane.

4.	 Select and highlight the Organization in the Navigator pane 
to which the Person will be moved. Make sure the information 
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for the organization appears in the Editor pane (otherwise the 
organization was not successfully selected).

5.	 Right-click in the Navigator pane and select menu option 
Paste. The Person’s name should appear under the selected 
organization. The Person should no longer appear under their 
previous home organization.

6.	  Click the Save button.

Screen Item Descriptions

•	 Honorific - Title of respect (Mr., Ms., Mrs., Rev.., Dr., The Honor-
able, etc.)

•	 Last Name - Last name of the person
•	 First Name - First name of the person
•	 Middle Initials - Middle initials of the person
•	 Initials - Initials of the person
•	 Email Address - Contact email address
•	 Contact Instructions - Contact instructions
•	 Business Hours - Business hours
•	 Voice Phone Number - Contact voice phone
•	 FAX Number - Contact fax phone
•	 Street Address - The street number and name, including apartment 

number
•	 Building Name/ID - The building in which the person works
•	 Room Number - The room number in which the person works
•	 City - The city in which the person lives or works
•	 State Province - The state in which the person lives or works
•	 Postal Code - The zip code for the person’s residence or business
•	 Country - The country in which the person lives or works
•	 Address Type - “MAILING ADDRESS” or “PHYSICAL AD-

DRESS”
•	 Address Type - Is this a residence or business address. Valid entries 

are: Residence, Business
•	 NOAA User ID - Firstname.Middlename.Lastname
•	 Job Title - The person’s job title
•	 Employer - The source of a person’s salary. Valid entries include (but 

ar not limited to): FED, JIMAR
•	 Employee Type - Federal, Commissioned, Contractor, Function, 

Associate
•	 Manager’s User ID - Manager’s user ID of the form Firstname.

Middlename.Lastname.
•	 Work Location - The primary business location for this person
•	 Expertise - Field or fields in which the person has specialized train-

ing or experience
•	 Routing Code - Employee routing code
•	 Organization Acronym - The acronym of the organization or agency 

that this person represents
•	 Additional Information - Supplemental information about this 

person

Organization Assignment Tab

Clicking on the Assignments tab for a Person will allow the user to manage the 
Person’s organization assignments.
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An Organization Assignment controls the Libraries in which the Person may be 
granted InPort User roles.

An assignment record is automatically created when a person record is created 
under an organization.  If the person is working in multiple organizations, the 
person can be assigned to the other organization(s), thus creating those assign-
ment records.  Assignment records can be edited, activated, and deactivated.  
Assignment records can only be deleted if they are not referenced anywhere else 
in the Library and must be deleted before the Person can be deleted from the 
InPort Catalog.

3.5  Library Manager - Org. Assignment Tab

The Library Manager’s Org. Assignment tab shows in which organizations the 
Person works.

How to Assign a Person to Additional Organizations

•	 From the InPort Catalog Tools menu, click on the button beside 
Library Manager.

•	 Select and highlight the Person’s name and home record in the 
Navigator pane. A person’s home record can be recognized by the as-
terisk before their status, e.g. Dana Stewart (*Active). Only a person’s 
home record is editable.

•	 Right-click in the Navigator pane and select menu option Copy. The 
Person’s name will appear the Clipboard area below the Navigator 
pane.

•	 Select and highlight the Organization in the Navigator pane to 
which the Person will have a new assignment. Make sure the infor-
mation for the organization appears in the Editor pane (otherwise 
the organization was not successfully selected).

•	 Right-click in the Navigator pane and select menu option Paste. The 
Org. Assignments tab should now be displayed in the Editor pane 
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and the Person’s name should appear under the selected organiza-
tion.

•	 In the Editor pane, fill out the Person’s position title and appropriate 
begin and end dates for the assignment if required.

•	 Click the Save button. 

Screen Item Descriptions

•	 Active? - Record status -- A(ctive), I(nactive)
•	 Organization - Organization Name (automatically filled in by the 

Add Organization Assignment process
•	 Position - The position held by the person (e.g., debriefer, analyst)
•	 From Date - First day of assignment to the org
•	 To Date - Last day of assignment to the org

InPort User Roles Tab

Clicking the InPort User Roles tab for a Person will display any processed or 
pending InPort User Role requests.

The New Role button on this tab will open up the INPORT USER ROLE 
MANAGER tool  in order to request a new InPort User Role.

Selecting an existing InPort User Role record in the table will enable the Edit/
View Role button, which can then be used navigate to that specific InPort User 
Role record in the INPORT USER ROLE MANAGER.

The User Mgmt. button allows the user to create and manage the Person’s InPort 
user account, including changing their password.

3.6  Library Manager -InPort User Tab
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Use the Library Manager’s InPort User Roles tab to view the Person’s InPort User 
roles.  The Librarian may also use the buttons to open the InPort User Role Man-
ager and User Manager tools for managing roles and InPort user accounts.  Note 
that no fields on this tab are entered or edited by the user.

Screen Item Descriptions

•	 Owner Organization Name - Owner Organization Name
•	 Library Title - Library Title
•	 InPort User Role Status - InPort User Role Status [Active, Inactive]
•	 Library/Project Title - Library/Project Title
•	 InPort User Role - InPort User Role [Author, Reader, etc.]
•	 InPort User Role Request Date - The date that this role was re-

quested
•	 InPort User Role Authorization Date - Date that this role was 

authorized
•	 InPort Username - InPort account username

InPort User Account Management
The INPORT USER MANAGER is used to create and manage InPort user ac-
counts.  This tool can be opened either from the LIBRARY MANAGER or the 
INPORT USER ROLE MANAGER.  It is important to note that only those people 
- registered in InPort as Persons - that will actually be managing metadata in 
InPort will require InPort user accounts.

How to Create a New InPort User Account

1.	 From either the Library Manager or INPORT USER ROLE 
MANAGER, click on the User Mgmt. button.

2.	 Enter the user’s password in both the Password field and the 
Password Confirmation fields.

3.	 Click the Create button.
4.	 If the requested username already exists, then follow the 

prompts to see if the existing user is also an InPort user or 
possibly the same user your are trying to create.  If necessary, 
choose another username and try again.

5.	 Click the Exit button to return to the original tool.

3.7  InPort User Manager - New User
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The InPort User Manager tool is used to create and manage InPort user accounts. 

How to Change an InPort User’s Password

1.	 From either the LIBRARY MANAGER or INPORT USER ROLE 
Manager, select the desired Person record, click on the InPort 
User Roles tab, and then click on the User Mgmt. button.

2.	 Enter the user’s new password in both the New Password field 
and the New Password Confirmation fields.

3.	 Click the Change Password button.
4.	 Click the Exit button to return to the original tool.

3.8  InPort User Manager - Existing User

The InPort User Manager can also be used to change passwords or lock/unlock the 
user’s account.

How to Lock or Unlock an InPort User Account

1.	 From either the LIBRARY MANAGER or INPORT USER ROLE 
MANAGER, select the desired Person record, click on the In-
Port User Roles tab, and then click on the User Mgmt. button.

2.	 If the user’s account is open then the Lock Button will be dis-
played.  If the user’s account is locked, then the Unlock button 
will be displayed.

3.	 Click the appropriate button.
4.	 Click the Exit button to return to the original tool.

InPort User Account Password Management

User account passwords in InPort follow NOAA rules and users will thus be 
required to change their passwords on a regular basis.  Users can manage their 
own passwords by first logging into the InPort web site and then clicking on the 
account link on the upper right corner of the Publication page.
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3.9  InPort Account Management Page

InPort users can change their login password from the InPort Account Manage-
ment page which is available after logging in to the web site.  InPort Librarians can 
also manage their user’s InPort accounts using the Library Manager tool.

InPort User Role Manager
The INPORT USER ROLE MANAGER allows InPort Administrators and Librar-
ians to grant specific InPort User Roles (Reader, Author, Publisher, Librarian, 
Data Steward), to InPort Persons for specific metadata Libraries and Projects.  If 
the Librarian wishes to grant access to specific Catalog Projects rather than the 
entire Library, then the Librarian must first create the Project(s) in the INPORT 
CATALOG EDITOR.
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3.10  InPort User Role Manager

This screen shows an authorized, active InPort User role.  The screen displays in 
this application are context sensitive and depends both upon the type of item 
selected in the Navigator pane and the status of that item.

The granting of an InPort User Role is a two step process.  A Request is gener-
ated for a specific Person, for a specific Role, in a specific Library or Project. 
At that time, the Librarian or InPort Administrator will specify which Data 
Steward or InPort Administrator is expected to Authorize (or possibly Reject), 
the User Role Request.  After the Request is saved, it will be marked as Pend-
ing.  Only a Pending request may be deleted.  Librarians are expected to main-
tain their normal in-house process or documentation for user computer and 
data access and while it is the Librarian who executes the final authorization or 
rejection of an Role Request, the Librarian will specify the Data Steward that 
actually signed off on the Request. 

Note that helpful information will be displayed at the bottom of the screen in 
the Tip area below the Editor pane.  The currently displayed Tip Text will depend 
on what action the user has just performed and should provide the user with 
what their next action should be.

The INPORT USER ROLE MANAGER can only be opened from the LIBRARY 
MANAGER tool from either the New Role button or the Edit/View Role button.

From the LIBRARY MANAGER, with a Person’s InPort User Roles tab displayed, 
clicking on the New Role button will open the INPORT USER ROLE MANAGER. 
The Navigator pane will be positioned at the Library of the Organization that 
was last selected in the LIBRARY MANAGER from which the user just came.  If 
that Organization does not yet have a Library, the Navigator Tree will be posi-
tioned at the first available Library.
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Note that clicking the Exit button will close the INPORT USER ROLE 
MANAGER and re-open the LIBRARY MANAGER.  Any new role information 
for the selected person will be reflected on the displayed InPort User Role tab.

With the selected Library expanded in the Navigator pane, all the possible 
InPort user roles will be visible. A Plus sign (+), to the left of the Role name will 
indicate that at least one Person has a pending or completed role of that type.

Creating InPort User Role Requests
3.11  User Role Manager - New Role Request

InPort User Role Manager - New Role 
Locate the Library or Project and select the role which the user needs.  Right click 
to select the New Request option or click the New Request button in the Editor 
Pane.  Follow the instructions in the Tip Area at the bottom of the Editor Pane.

How to Create an InPort User Role Request

1.	 To create a new InPort User Role request, in the INPORT USER 
ROLE MANAGER, select the appropriate role under the Li-
brary or Project that needs that role. The user may either click 
the New Request button or right-click to select the New Request 
menu option.

2.	 Clicking on the New Request button disables (grays out), the 
Navigator pane and displays the New Request fields in the 
Editor pane

3.	 The Catalog Role field and request date will already be filled 
out. Per the Tip Text, select an InPort User and the Expected 
Authorizer from their pop-lists.  You may choose to write notes 
in the Request Notes field.

4.	 Click the Save button to complete the request and re-enable 



the Navigator pane.

Authorizing or Rejecting an InPort User Role Request

3.12  InPort User Role Manager - Pending Request

A completed request appears as a Pending request in the Navigator Pane.  This 
request may still be deleted at this point, if needed.

How to Complete a Pending User Role Request

1.	 Frequently, there will be a lag time between requesting and 
authorizing (or rejecting) a User Role.  For that reason, the 
Librarian and InPort Administrator may navigate directly to 
a person’s Pending User Role request in the INPORT USER 
ROLE MANAGER by selecting the role request record in the 
LIBRARY MANAGER, InPort User Role tab for the Person in 
question, and then clicking on the Edit/View Role button.

2.	 When the INPORT USER ROLE MANAGER opens, the Naviga-
tor pane will have the Persons role request record selected.

3.	 Select the appropriate Data Steward or InPort Administrator 
from the Auth/Rej By field.  This will lock the Navigator pane.

4.	 Click on the Authorize or Reject button to complete the role 
request, or click on Cancel to abort the process and leave it as 
a Pending request. 

5.	 Click the Save button after completing the request to com-
plete the process and re-enable the Navigator pane.

Note that InPort User Role authorization will require that the Person being granted 
the role must first have an active InPort user account.  The Librarian may use the User 
Mgmt. button to create, unlock/lock the account or change the user’s password. This 
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function is also accessible directly from the LIBRARY MANAGER, InPort User Roles 
tab.

De-activating or Re-activating an Authorized Role
3.13  InPort User Role Manager - Inactive Role

An authorized user role may be subsequently deactivated or reactivated by toggling 
the Active check box.

How to Deactivate or Reactivate an InPort User Role

1.	 Using the INPORT USER ROLES MANAGER, authorized 
requests may not be deleted, but they may be deactivated, or 
reactivated by toggling the Active check box.

2.	  Click the Save button to complete that action.

User Roles Report

A list of the InPort Persons that are granted user roles for a given Library, Proj-
ect, or Catalog Item is available from both the Library Manager and Catalog 
Editor.  This report will display in the user’s browser and can then be printed.

How to Generate a User Roles Report

1.	 From either the LIBRARY MANAGER or CATALOG EDITOR, 
select a Library or Catalog Item in the Navigator pane.

2.	 Right-click in the Navigator pane and select menu option 
Show User Roles.



3.	 The report will display in the user’s default browser. If desired, 
use the browser’s print function to print the report.

3.14  InPort User Roles Report

This InPort User Roles Report can be generated from either the Library Manager 
or Catalog Editor.
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4.  Catalog Maintenance

InPort Catalog Organization
Catalog items are organized in a parent-child hierarchy with the top of the hier-
archy being the organization’s InPort Library.  The collection of InPort Libraries 
make up the InPort Catalog.  When an InPort user logs into the InPort Catalog 
Editor, they will see all the Libraries for which they have an active InPort User 
Role (Reader, Author, Publisher, etc.).

Catalog item types include...

•	 Metadata Library(*)
•	 Project
•	 Data Set 
•	 Data Entity
•	 Document
•	 Procedure

(*) The Metadata Library is a special Catalog Item that represents all the cur-
rently cataloged data collection activities of an Organization.

Catalog items are organized in a hierarchy according to the following rules:

•	 Each catalog item may belong to one-and-only-one parent catalog 
item

•	 Each catalog item may be the parent of one or more catalog items
•	 Each catalog item may not be the parent of itself

InPort Catalog Editor
The INPORT CATALOG EDITOR tool is used for:

•	 Creating Catalog (metadata) Items in a Library Hierarchy
•	 Reviewing, revising, and approving information in the catalog
•	 Moving Catalog Items within a Library Hierarchy
•	 Publishing Catalog Items to internal users or the public

The Catalog Editor is the main tool for entering, editing, and publishing an 
organization’s metadata within their InPort Library.  Librarians will be able 
to organize their metadata into Projects.  Under a Project, different types of 
metadata may be stored, including documents, data sets, tables, reports, images, 
procedures, as well as sub-projects or any Set of similar items.  The method of 
organizing an InPort Library is ultimately the responsibility (and privilege!) of 
each InPort Librarian.

The Catalog Editor is arranged in pages or Tabs.  Each tab allows the user to 
enter a different type of information.  All Catalog Items will have display the 
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Item ID tab where the item’s Name, Title, Abstract, Purpose, Keywords, and Lo-
cation will be entered.  Based on the Catalog Item Type (e.g., Document, Data 
Set, Project), additional Detail tab pages will be displayed.  For example, all item 
types will have a tab page for Time Frame (start/end) information, Geographic 
Area coverage, Support/Contact Roles, and Access/Security information.  Ad-
ditionally, Projects will have tab pages for Acronym descriptions, glossary terms 
and FAQs.  In short the Catalog Editor should supply the user with appropriate 
tabs for storing all the diverse types of metadata collected by the user’s organiza-
tion.

How to Create New Catalog Items

1.	 From the INPORT CATALOG TOOLS menu, click on the button 
beside Catalog Editor.

2.	 Select and highlight the appropriate Catalog Item or Library in 
the Navigator pane, under which you want to create the new 
item

3.	 Right-click and select menu option New Item or click the Add 
button in the Editor pane.

4.	 In the Catalog Item Type pop-list, select a Catalog Item Type
5.	 Complete the desired fields on the Item ID tab and the addi-

tional tab that is named for the chosen item type (e.g., Project, 
Data Set).

6.	 The user may choose to further describe the item using any of 
the Detail Modules (e.g., Time Frame, Support Roles),  available 
for the chosen item type.

How to Move a Catalog Item to a Different Parent Item

1.	 In the Catalog Navigator pane, select the item to be moved. 
Important: the item is selected ONLY if you see its details in 
the Editor pane on the right.

2.	 Right click on the selected item and choose menu option Cut. 
The name of the selected item will appear below the Naviga-
tor pane in the box labeled Clipboard.

3.	 Select the new Parent Item under which you want to place the 
item you cut to the Clipboard. Again, ensure that you can see 
this parent item in the Editor pane.

4.	 Right click on the new Parent Item and choose menu option 
Paste.

5.	 If the move to the new Parent Item will produce a valid parent-
child relationship, the user will be asked to confirm or Cancel 
the operation.

6.	 When the user confirms the operation, the Catalog Item that 
was placed in the Clipboard will move to the new location.

How to Delete All Childless Children of a Catalog Item

Note that the deleting of Catalog Items is only possible if the item has no child 
items and the item is in the either Draft or Review/Revise workflow state.  Nor-
mally, deletion of  a Catalog Item is performed by clicking on the Delete button 
on the item’s Item ID tab.  However, it is possible to delete all child items under 
certain conditions (parent and all child item workflow states are all Draft or Re-
view/Revise AND the child items have no children.  This ability is particularly 
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useful should a user batch load many tables under a data set catalog item and 
wish to delete them all without deleting the parent data set.  

1.	 In the Catalog Navigator pane, select the parent of the items 
to be deleted. Important: the item is selected ONLY if you see 
its details in the Editor pane on the right.

2.	 From the top menu bar choose Tools>Delete Child Records. 
3.	 Confirm your action to delete all childless children of the cur-

rently selected item.  Notes that there is no Undo for this ac-
tion.  Deletion is permanent.  Child items that had child items 
themselves will not be deleted.

Find Next

Use the Search box and Find Next button to locate a catalog item where the 
search string is found in the Title of an item.  Repeat clicking the Find Next if 
needed.

Find Last Edited

Select Menu option Bookmarks>Last Item Edited to jump to the last catalog 
item the current user had created or modified.

Catalog Reports

Users can access useful reports from the Main Menu -> Reports option.

•	 Catalog Item Report for the current item
•	 Fillable Catalog Item Form for current item
•	 Fillable Catalog Item Forms for each catalog item type
•	 Catalog Item History Report for the current item
•	 Catalog Hierarchy Report for the current item and all descendents
•	 User History Report for the currently logged in user
•	 User Roles Report for the currently selected item

These reports will be displayed in a browser window which can then be printed 
or saved.  The Catalog Item Report and blank fillable item forms are very useful 
for offline interviews of the various support persons that will have documenta-
tion and metadata.

Catalog Hierarchy Report

The user may produce and print a report showing all of the catalog items that 
descend from the currently selected catalog item.  This report will show Title,  
Workflow State, and relationships of all catalog items as an hierarchical map.



4.1  Catalog Editor - Catalog Hierarchy Report

The user may generate and print a Catalog Hierarchy Report to obtain a graphical 
representation of all the descendents of a selected Catalog Item.

How to Generate a Catalog Hierarchy Report

1.	 From the CATALOG EDITOR, select a Library or Catalog Item 
in the Navigator pane.

2.	 From the top menu bar select Reports>Hierarchy Report
3.	 Use the browser print function to print the report.  May also 

use the browser search or find function

User Roles Report

A list of the InPort Persons that are granted user roles for a given Library, Proj-
ect, or Catalog Item is available from both the Library Manager and Catalog 
Editor.  This report will display in the user’s browser and can then be printed the 
the browser print function or icon.
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4.2  Catalog Editor - Roles Report

The user may generate and print a User Roles Report to obtain a list of the people 
granted roles for reading, creating, editing, and/or publishing the selected catalog 
item

How to Generate a User Roles Report

1.	 From either the CATALOG EDITOR, select a Library or Catalog 
Item in the Navigator pane.

2.	 From the top menu bar select Reports>User Roles Report
3.	 Use the browser print function to print the report



Catalog Item History Report
4.3 Catalog Editor - Catalog Item History Report

The Catalog Item History Report will show the full edit history of a catalog item.

How to Generate a Catalog Item History Report

1.	 From the CATALOG EDITOR, select a Library or Catalog Item 
in the Navigator pane.

2.	 From the top menu bar select Reports>Catalog Item History 
Report

3.	 Use the browser print function to print the report.  May also 
use the browser search or find function
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User History Report
4.4 User History Report

The User History Report will display all the transactions the current user has made, 
regardless of which catalog item is selected.

How to Generate a User History Report

1.	 From the CATALOG EDITOR, select a Library or Catalog Item 
in the Navigator pane.

2.	 From the top menu bar select Reports>User History Report
3.	 Use the browser print function to print the report.  May also 

use the browser search or find function



Selected Catalog Item Fillable Form

4.5 Selected Item Fillable Form

Users may wish to print out a catalog item form for the currently selected item 
where information already entered for the item is displayed along with blank fields 
for all other fields or sets of fields, in order to facilitate gathering information for 
completing the catalog item. 

How to Generate a Selected Catalog Item Fillable Form

1.	 From the CATALOG EDITOR, select a Library or Catalog Item 
in the Navigator pane.

2.	 From the top menu bar select Reports>Fillable Catalog Item 
Forms>Selected

3.	 Use the browser print function to print the report.  May also 
use the browser search or find function
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Blank Catalog Item Type Fillable Form

4.6 Blank Project Item Form

Users may wish to print out an appropriate blank catalog item form in order to 
facilitate gathering information for input to InPort.

How to Generate a Blank Catalog Item Type Fillable Form

1.	 From the CATALOG EDITOR, select a Library or Catalog Item 
in the Navigator pane.

2.	 From the top menu bar select Reports>Fillable Catalog Item 
Forms>[Document, Project, Data Set, Entity, Procedure]

3.	 Use the browser print function to print the report

	 InPort Catalog v 2.0 User Guide 03.22.2012  |     51



Catalog Item Identification

4.7  Catalog Editor - Item Identification Tab

InPort Catalog Editor showing the Item Identification tab.  This tab is common 
to every catalog item type and is used to describe the basic information about the 
identification, purpose and location of the catalog item.

Screen Item Descriptions

•	 Item Type - Type of catalog item. Options currently include: Data 
Collection Item, Data Set, Data Entity, Document, Procedure, and 
Project

•	 Item Status - Data status of this catalog item. Options include: 
Complete, In Work, Planned

•	 Item Name - Short name, alias, or familiar name of the catalog item
•	 Item Title - Title for the InPort metadata record. The title should be 

as descriptive as possible, employing terms that clearly identify the 
specific subject and unique contents of the record.

•	 Abstract - The abstract should clearly reference the specific subject 
and unique dimensions of the resource being documented, along 
with explicit consideration of major scientific concepts keywords, 
and other descriptive terms to aid system users in searching through 
the metadata records and identifying relevant ones. FGDC Refer-
ence

•	 Purpose - Purpose or a summary of intentions with which the item 
was developed

•	 Notes - General notes about this catalog item
•	 Theme keywords - Common use word or phrase to describe the 

subject of the data set
•	 Place keywords - Geographic name of a location covered by a data 
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set
•	 Temporal keywords - The name of a time period covered by a data 

set
•	 Stratum keywords - Name of a vertical location used to describe the 

locations covered by the data set
•	 Other Citation Details - Other information required to complete 

the citation
•	 Supplemental Info. - Supplemental Information that should ac-

company any distributed metadata for this item or data set.  Other 
descriptive information about the data set

•	 Catalog Item ID - Catalog Item primary key
•	 Publication status - Publication status -- (U)npublished, (I)nternally 

Published, (E)xternally Published, (W)ithdrawn; displayed in header 
of the CATALOG EDITOR

•	 Owner Org - Organization that is the steward, owner, or caretaker 
of this data item

Physical Location

4.8  Catalog Editor - Physical Location Tab

InPort Catalog Editor showing the Physical Location tab.  This tab is common 
to every catalog item type and is used to describe physical location of the catalog 
item.

Screen Item Descriptions

•	 Physical Loc - Organization - Organization where catalog item is 
physically located

•	 Physical Loc - City - Physical location of the catalog item -- city
•	 Physical Loc - State/Province - Physical location of the catalog item 
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-- state or province
•	 Physical Loc - Country - Physical location of the catalog item -- 

country
•	 Physical Loc - Description - Physical location of the catalog item 

-- narrative description

Catalog Item Types

Project

Project type catalog items can be thought of as metadata portfolio or folder.  A 
Project catalog item might, indeed, describe a real-life data project. It might also 
be used as a convenient way to describe a set of related items under which each 
of the collected items may be cataloged. 

4.9 Example of a Library hierarchy with multiple levels of Projects

Project Folder B

Project Type: Data System

InPort Metadata Catalog
Project

Project Folder B3

Project Type: General
Collection

InPort Web Pages

Project Folder B2

Project Type: Data 
Collection

InPort Metadata Catalog

Project Folder B1

Project Type: Task

InPort Development

Project Folder C

Project Type: Data
Collection

Lobster

Project Folder A

Project Type: Collection

Longline Logbook

Metadata Library

PIFSC

Project Folder B4

Project Type: General
Collection

InPort Tools

 The above example shows multiple levels of catalog Projects in a Library hierarchy.  
Each Project folder might contain many other catalog item types besides those 
shown in the example.

A catalog item of type Project can be thought of as a metadata folder or portfo-
lio that contains one or more Catalog Items of any type - including other Project 
items.  Each Project can contain the metadata for an organization’s:

•	 Program
•	 Project
•	 Task
•	 Activity
•	 Data Collection Effort
•	 Data System
•	 Set of… (related catalog items, such as documents, collection forms, 

data collection items, etc.) 
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4.10  Example of catalog Projects in a Library hierarchy

Project

Folder Type: Data System

Title: Hawaii Longline
Observer Data System

Described with:

Data System Details...
URLs…
Time Frame…
Geographic Area…
Acronyms…
Glossary Terms...

Project

Folder Type: Task

Title: LODS Quarterly Reports

Described with:

Task Details…
URLs...
Time Frame…
Roles…

Metadata Library

Title: PIRO

Project

Folder Type: Set of...

Title: The Set of LODS Data
Collection Items

Described with:

URL…
Time Frame...
Person Role...

Data Set

Data Set Type: Database

Title: Hawaii Longline
Observer Data System Oracle
Database

Described with:

Time Frames...
Roles...
Issues...
Technical Environment...
Access Details...

Document Data Collection Item

Procedure

Title: LODS Quarterly
Procedure

Described with:

Procedure Steps...
Roles...
Time Frame…

Document
Document

Title: LODS 2004Q1 Quarterly
Report

Described with:

Report Details…
URLs...
Time Frame…
Data Quality…
Access Info…
Downloads...

Data Collection Item
Data Collection Item

Data Collection Item

Title: Sea Surface Temp.

Described with:

Time Frames...
Roles...
Issues...
FAQs...

InPort Projects can be thought of as metadata folders that can be used to describe 
an organization’s project, program, task, or activity. A Project may be the parent 
item of other projects.

Each Project can be fully described, just like any other catalog item type, and can 
include details of the following detail modules:

•	 Support Roles
•	 Geographic Area
•	 Time Frames
•	 Access/Security Info
•	 URLs
•	 Activity Log
•	 Issues
•	 Technical Environment
•	 Data Quality
•	 Acronyms
•	 Glossary Terms
•	 FAQs
•	 Downloads
•	 Related Items

Each Project can itself contain child catalog items of type:



•	 Project
•	 Data Set
•	 Data Entity, e.g., tables, spreadsheets, maps, etc.
•	 Documents
•	 Procedure

4.11  Catalog Editor - Project Tab

After completing the Item ID tab for a new catalog Project, the user should 
complete the Project tab to specify the type of project.  Complete the Collection 
Details section only if the Project describes a data collection effort.

Screen Item Descriptions

•	 Project Type - Type of project. Options include: Project, Program, 
Data Collection, Data System, Task, Activity, Set of ... (User de-
fined)

•	 Project Status - Status of the Project (Active, Completed, In Devel-
opment, Suspended)

•	 Mandated? - Is this project required by law or other regulation?
•	 Mandated By - What law or regulation mandates this project?
•	 Collection Type - (This and the following two items should be filled 

out for data collection projects.)  Type or category of the collection 
project: e.g., Landings, Logbook, Observer, Permit, Socio-economic, 
VMS, other

•	 Collection Authority - Administrative unit of government authoriz-
ing/funding this collection

•	 Collection Method(s) - Method(s) used to collect data: Electronic, 
Paper, Electronic and Paper, etc.
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How to Document a Project, Program, Task, or Activity

1.	 From the INPORT CATALOG TOOLS menu, click on the button 
beside Catalog Editor.

2.	 Select and highlight the appropriate parent Library name in 
the Navigator pane.

3.	 Right-click and select menu option New Item or click the Add 
button in the Editor pane.

4.	 In the Catalog Item Type pop-list, select Project.
5.	 In the Editor pane, fill out the Identification in the Item ID Tab.    

Starred items are required fields.
6.	 Click on the Project Tab and complete fields that can describe 

the project or activity.  Note that Collection Project items are 
not required for non-data collection projects.

7.	 The user may further document the project using the available 
Detail Module Tabs. (See Detail Modules section for further 
information.)

8.	 Click the Save button.

Data Set

A catalog item of type Data Set can describe...

•	 a Database
•	 a collection of related data Files
•	 a set of reports that contain data
•	 other (as described in Abstract)

An InPort catalog item of type Data Set is used to describe a set of related 
objects that contain data such as a database, a collection of flat files, or a set of 
reports that contain data.  Data Sets contain one or more Data Entities (e.g., 
Tables, Reports, Files) that describe their attributes (fields or columns).  



4.12  Example of a catalog Data Set in a Library hierarchy

Project

Project Type: Data System

Title: Hawaii Longline
Observer Data System

Described with:

Data System Details...
URLs…
Time Frame…
Geographic Area…
Acronyms…
Glossary Terms...

Data Set

Data Set Type: Database

Title: Hawaii Longline
Observer Data System Oracle
Database

Described with:

Time Frames...
Roles...
Issues...
Technical Environment...
Access Info...

Document

Procedure

Title: LODS Quarterly
Procedure

Described with:

Procedure Steps...
Roles...
Time Frame…

Document
Document

Title: LODS 2004Q1 Quarterly
Report

Described with:

Report Details…
URLs...
Time Frame…
Data Quality…
Access Info…
Downloads...

Data Entity
Data Entity

Data Entity

Title: Table - Trips

Described with:

Time Frames...
Roles...
Issues...
FAQs...

Domain
Domain

Domain

Title: Latitude.

Described with:

Time Frames...
Roles...
Issues...
FAQs...

Data Sets will most likely have one or more Data Entity child items.

Each Data Set can be fully described, just like any other catalog item type, and 
can include details of the following detail modules:

•	 Support Roles
•	 Geographic Area
•	 Time Frames
•	 Access/Security Info
•	 URLs
•	 Activity Log
•	 Issues
•	 Technical Environment
•	 Data Quality
•	 FAQs
•	 Downloads
•	 Related Items

Each Data Set can itself contain child catalog items of type:

•	 Data Set
•	 Data Entity, e.g., tables, spreadsheets, maps, etc.
•	 Data Collection Item
•	 Document
•	 Procedure
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4.13  Catalog Editor - Data Set Tab

After completing the Item ID tab for a new catalog Data Set, the user should 
complete the Data Set tab to specify the type of data set  This tab also allows for 
descriptions of the entities and attributes - tables and columns - contained in the 
data set.

Screen Item Descriptions

•	 Data Set Type - A general description of the Data Set. Examples: 
Database, Flat files, Mixed, Set of reports, etc.

•	 Data Set Maintenance Frequency - Frequency w/ which changes 
and additions are made (e.g., Continuous, Weekly, Quarterly)

•	 Data Set Entity - Attribute Overview - Detailed summary of the 
information contained in a data set

•	 Data Set Entity - Attribute Detailed Citation - Reference to the 
complete description of the entities, including column names and 
formats

•	 Data Set Entity - Attribute Detailed Citation URL - URL to entity 
attribute detail citation

•	 Source Media Type - Data Set source media type

How to Catalog a Data Set, Database, or File Collection

1.	 From the INPORT CATALOG TOOLS menu, click on the button 
beside Catalog Editor.

2.	 Select and highlight the appropriate parent Library name in 
the Navigator pane. 

3.	 Select and highlight the Catalog Item under which the new 
Data Set will be cataloged.

4.	 Right-click and select menu option New Item or click the Add 
button in the Editor pane. 



5.	 In the Catalog Item Type pop-list, select Data Set.
6.	 In the Editor pane, fill out the Identification information in the 

Item ID tab.    Starred items are required fields.
7.	 Click on the Data Set tab and complete the fields that can best 

describe the data set, database, or file collection that is being 
cataloged.  

8.	 The user may further document the data set using the various 
Detail Module tabs. (See Detail Modules section for further 
information.)

9.	 Click the Save button.

Data Entity

Catalog Item type Data Entity is used to describe a data table or data file or 
report that itself contains attributes (columns or fields of data).  InPort Data 
Entities are typically child items of InPort Data Sets.  Data Entities may have 
child items of type Procedure or Document.

A catalog item of type Data Entity can describe...

•	 a data table
•	 a data file
•	 a data report
•	 a spreadsheet
•	 a data entry form with data
•	 an xml file
•	 other (user defined)

Unlike other Catalog Item types, Data Entities and their Attribute information 
may be batch loaded into InPort see Chapter 7 for complete information.
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4.14  Example of catalog Data Entity in a Library hierarchy

Data Entity

Title: Table - Trips

Described with:

Data Attributes...
Time Frames...
Roles...
Issues...
FAQs…
Related Items...

Procedure

Title: Trips Table Validation

Described with:

Procedure Steps...
Roles...
Time Frame…

Document

Title: Trips Table
Documentation

Described with:

Report Details…
URLs...
Time Frame…
Data Quality…
Access Info…
Downloads...

Data Set

Data Set Type: Database

Title: Hawaii Longline
Observer Data System Oracle
Database

Described with:

Time Frames...
Roles...
Issues...
Technical Environment...
Access Details...

Data Entities are most frequently thought of as Tables.  Data Entities normally are 
child items of a catalog Data Set.

Each Data Entity can be fully described, just like any other catalog item type, 
and can include details of the following Detail Modules:

•	 Data Attributes
•	 Support Roles
•	 Time Frames
•	 Access/Security Info
•	 URLs
•	 Activity Log
•	 Issues
•	 Technical Environment
•	 Data Quality
•	 FAQs
•	 Downloads
•	 Related Items

Each Data Entity can itself contain child catalog items of type:

•	 Document
•	 Procedure



4.15  Catalog Editor - Data Entity Tab

After completing the Item ID tab for a new catalog Data Entity, the user should 
complete the Data Entity tab to describe the type of entity.  Data Entity and 
Attribute information may also be loaded into InPort through the Batch Loader 
process.

Screen Item Descriptions

•	 Entity Type Code - The word ‘Entity’ is used to describe a data 
holding of some type.  Entity types include Data file, Data table, 
Report, Spreadsheet, Form (data collection or data entry), XML 
document, etc)

•	 Active Version? - Is this the active (currently in use) version of the 
table/entity?

•	 Alias - Code or short name for the table or entity (e.g., org for 
organization)

•	 Schema Name - If Oracle, SQL Server, or MySQL, the schema 
name in which the table resides

•	 Description - Detailed description of the entity
•	 Change Summary - Summary description of changes to this version 

of the table from the previous version

Data Attributes

Each data attribute is significant as a piece of data collected and stored in a table, 
field, cell, or form or a calculated value. Data attribute records always reside under a 
Data Entity parent item.
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4.16  Catalog Editor - Data Attributes Tab

After completing the Data Entity tab, the user can use the Data Attributes tab to 
describe the details of the individual attributes - columns - contained in the data 
entity.  Note that the user may choose to use the Batch Loader process to load 
table/column information into the InPort Catalog.

Screen Item Descriptions

•	 Order - The numeric order of the column in the table/spreadsheet 
layout

•	 Attribute Name - The name of the attribute (column name)
•	 Data Storage Type - The architectural data type (such as Oracle’s 

VARCHAR2 data type)
•	 Max Length - Maximum length of this column for character-type 

data; max length for Oracle NUMBER data type is always 22; see 
also definitions for data_precision and data_scale for NUMBER 
data type; max length is not meaningful for Oracle DATE data type

•	 Data Precision - For Oracle NUMBER data type, the total number 
of digits. Oracle guarantees the portability of number with precision 
ranging from 1 to 38.

•	 Data Scale - For Oracle NUMBER data type, the number of digits 
to the right of the decimal point. The scale can range from -84 to 
127. ‘Decimal’ length from other database types should be put in this 
column

•	 Required? - Is this column always required (cannot be null)?
•	 Primary Key? - Is this column the primary key or part of the pri-

mary key?
•	 Status - Status of this attribute (Active, Inactive, In Development, In 

Review).  The default is Active)
•	 Description - Narrative description of the attribute



•	 Data Collection Item - InPort Data Collection Item associated with 
this attribute.  (This item is not currently available.)

•	 General Data Type - The general data type of the column (Charac-
ter, Integer, Real Number, Date)

•	 Case Restriction - Indicate whether the column is to be stored as 
Upper, Lower or Mixed case

•	 Format Mask - Pattern used as a format aid during data entry
•	 Display Example - An example of how the data will be displayed to 

users
•	 Minimum Length - Minimum length of this column for charac-

ter-type data; see also definitions for data_precision and data_scale 
(NUMBER data type); min length not meaningful for Oracle 
DATE data type

•	 Unit of Measure - If applicable, record the proper unit of measure 
for this column (e.g., grams, inches, degrees Fahrenheit, etc.)

•	 Null Value - The symbol used in this table, view or report to repre-
sent a null value

•	 Null Value Meaning - If a value is used to represent a null, what is 
the specific meaning of the value

•	 Domain - The InPort Domain used by this attribute. Please use 
column Validation_Rules to indicate an Oracle Domain used by this 
attribute.

•	 Allowed Values - List of possible values or range of values for this 
column

•	 Default Value - If desired, the value to be placed in the column 
when no data is entered

•	 Foriegn Key Relations - List tables with which this column has 
foreign key relations

•	 Derivation - If this data element is derived, give the algorithm or 
expression that describes how this data element’s value is established

•	 Validation Rules - List validation rules or references to validation 
rules for this column

•	 Version - Column not currently in use. Column definition: Latest 
version of this column (this is NOT the data set version number)

•	 Decimals - Column not currently in use

How to Catalog a Data Entity with Data Attributes (Tables and Columns)

Note that there are two methods for cataloging Data Entities within InPort.  
This method outlines the process for hand entering information.  Alternately, 
if the Data Entity is a table in a database, the information may be downloaded 
from the user’s local data dictionary and uploaded with the InPort Batch Load 
tools (see Batch Loading section of this user guide).

1.	 From the INPORT CATALOG TOOLS menu, click on the button 
beside Catalog Editor.

2.	 Select and highlight the appropriate parent Library name in 
the Navigator pane.

3.	 Select and highlight the Catalog Item - most likely of type 
Data Set - under which the Data Entity will be cataloged.

4.	 Right-click and select menu option New Item or click the Add 
button in the Editor pane.

5.	 In the Catalog Item Type pop-list, select Data Entity.
6.	 In the Editor pane, fill out the Identification information in the 

Item ID tab.    Starred items are required fields.
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7.	 Click on the Data Entity tab and complete the fields that can 
best describe the document that is being cataloged. 

8.	 Click on the Attributes tab to fill out information about the at-
tributes or columns associated with the Data Entity item. 

9.	 The user may further document the Data Entity using the vari-
ous Detail Module tabs that are available for data entities.

10.	 Click the Save button.

Document

A catalog item of type Document can describe any existing document.  Most 
frequently, documents are child items of the catalog items they are derived or 
relate to.  However, users may wish to create document folders via InPort Project 
catalog items if they wish to organize document collections.

4.17  Documents in a Library Hierarchy

Project

Project Type: Data System

Title: Hawaii Longline
Observer Data System

Described with:

Data System Details...
URLs…
Time Frame…
Geographic Area…
Acronyms…
Glossary Terms...

Project

Project Type: Task

Title: LODS Quarterly Reports

Described with:

Task Details…
URLs...
Time Frame…
Roles…

Project

Project Type: Set of...

Title: The Set of LODS Data
Collection Forms used at sea.

Described with:

URL…
Time Frame...
Person Role...

Document
Document

Document

Title: LODS 2004Q1 Quarterly
Report

Described with:

Report Details…
URLs...
Time Frame…
Data Quality…
Access Info…
Downloads...

Document
Document

Document

Title: LODS Trip Specification
Form

Described with:

URL...
Time Frame…
Downloads...

Documents cannot have child catalog items.  If a document contains data that 
should be described with a procedure or data attributes, then it would be preferable 
to catalog the item as a Data Entity.

Each Document can be fully described, just like any other catalog item type, and 
can include details of the following Detail Modules:

•	 Support Roles
•	 Geographic Area
•	 Time Frames
•	 Access/Security Info
•	 URLs
•	 Activity Log
•	 Issues



•	 Data Quality
•	 FAQs
•	 Downloads
•	 Related Items

Documents cannot themselves contain other child catalog items.  If a document 
contains data, and thus needs to be described with procedures or attributes, then 
it should probably be cataloged as a catalog type Data Entity.

4.18 Catalog Editor - Document Tab

After completing the Item ID tab, the user can use the Document tab to describe 
the details of the document being cataloged.

Screen Item Descriptions

•	 Document Publication Date - Date the document was published
•	 Document Type - Document types include (but are not limited to): 

Thesis, Report, Book, Conference Proceedings, Journal article, Meet-
ing Minutes, Newsletter, FAQ, Technical Memorandum, Adminis-
trative Report, Graphic, Map, Legal Document, Letter, Presentation, 
Historical Account, Reference, Excerpt, Interview, News Release, 
Specifications

•	 Document Format Type - Valid document formats include (but are 
not limited to): DOC, WPD, TXT, HTM

•	 Document Format Version - The version of the software in which 
the document is stored

•	 Document Status - The development stage of the document: Draft, 
Final, In Review, Planned, Published
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How to Catalog a Document

1.	 From the INPORT CATALOG TOOLS menu, click on the button 
beside Catalog Editor.

2.	 Select and highlight the appropriate parent Library name in 
the Navigator pane.

3.	 Select and highlight the Catalog Item under which the docu-
ment will be cataloged.

4.	 Right-click and select menu option New Item or click the Add 
button in the Editor pane.

5.	 In the Catalog Item Type pop-list, select Document.
6.	 In the Editor pane, fill out the Identification information in the 

Item ID tab.    Starred items are required fields.
7.	 Click on the Document tab and complete the fields that can 

best describe the document that is being cataloged. 
8.	 The user may further document the project using the various 

Detail Module tabs that are available for documents.
9.	 Click the Save button.

Procedure

A catalog item of type Procedure can describe a procedure, protocol, or process 
that is relevant to a parent catalog item.  Documenting the procedures used to 
collect data, create and submit an annual data report, or even a procedure to 
extract data from a database are invaluable for documenting data collections and 
aiding future users and data managers on how to process and desseminate data.



4.19  Procedures in a Library Hierarchy

Project

Type: Task

Title: LODS Quarterly Reports

Described with:

Task Details…
URLs...
Time Frame…
Roles…

Procedure

Title: LODS Quarterly
Procedure

Described with:

Procedure Steps...
Roles...
Time Frame…

Document
Document

Title: LODS 2004Q1 Quarterly
Report

Described with:

Report Details…
URLs...
Time Frame…
Data Quality…
Access Info…
Downloads...

Each Procedure can be fully described, just like any other catalog item type, and 
can include details of the following Detail Modules:

•	 Support Roles
•	 Time Frames
•	 Access/Security Info
•	 URLs
•	 Activity Log
•	 Issues
•	 Technical Environment
•	 Data Quality
•	 FAQs
•	 Downloads
•	 Related Items

Each Procedure can itself contain child catalog items of type:

•	 Document
•	 Procedure
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4.20  Catalog Editor - Procedure Tab

After completing the Item ID tab, the user can use the Procedure tab to list the 
detailed steps of the procedure being cataloged.  Note that the user may also 
choose to add a child document item to the procedure rather than cataloging the 
procedure steps.

Screen Item Descriptions

•	 Procedure Type - The type of procedure. Valid entries include but 
are not limited to: Acquisition, Manipulation

•	 Step Order - The numerical order of the step in the procedure
•	 Step Label - Step label
•	 Step Name - Descriptive name of the step in the procedure (more 

descriptive than label
•	 Step Details - Detailed narrative explaining the procedure
•	 Step Purpose - Purpose of the procedure
•	 Start Date - Start date of the procedure
•	 End Date - End date of the procedure

How to Catalog a Procedure

1.	 From the INPORT CATALOG TOOLS menu, click on the button 
beside Catalog Editor.

2.	 Select and highlight the appropriate parent Library name in 
the Navigator pane.

3.	 Select and highlight the Catalog Item under which the new 
procedure will be cataloged.

4.	 Right-click and select menu option New Item or click the Add 
button in the Editor pane.

5.	 In the Catalog Item Type pop-list, select Procedure.



6.	 In the Editor pane, fill out the Identification information in the 
Item ID tab.    Starred items are required fields.

7.	 Click on the Procedure tab and complete the fields that can 
best describe the procedure that is being cataloged. 

8.	 The user may further document the Procedure using the vari-
ous Detail Module tabs that are available for procedures.

9.	 Click the Save button.

Data Collection Item

Note that the Data Collection Item module will be released for use in a subse-
quent version of InPort.  We include it here in order for users to become familiar 
with this new and powerful concept of documenting individual collected data 
types.

The catalog item type Data Collection Item is used to describe the collection of 
a specific type of information within a data collection project/effort.  Examples 
of data collection items include: trip number, sea-surface temperature, and hook 
type.  A well documented data collection system will include information on the 
history, purpose, collection methods, and business rules for each type of informa-
tion, or data collection item, which is collected.

4.21  Data Collection Items in a Library Hierarchy

Project

Project Type: Set of...

Title: The Set of LODS Data
Collection Items

Described with:

URL…
Time Frame...
Person Role...

Data Collection Item
Data Collection Item

Data Collection Item
Data Collection Item

Title: Sea Surface Temp.

Described with:

Time Frames...
Roles...
Issues...
FAQs...

Each Data Collection Item can be fully described, just like any other catalog 
item type, and can include details of the following Detail Modules:

•	 Related Items
•	 URLs 
•	 Time Frames
•	 Contact Information (Person/Org Roles)
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•	 Issues
•	 Data Quality
•	 Access Info
•	 Downloads
•	 FAQs
•	 Glossary Terms

Each Data Collection Item can itself contain child catalog items of type:

•	 Document
•	 Procedure

4.22  Catalog Editor - Data Collection Item Tab

After completing the Item ID tab, the user can use the Data Collection Item tab 
to describe the details pertinent to the item.

Screen Item Descriptions

•	 Short Definition - A brief definition of the data collection item
•	 Long Definition - Detailed, comprehensive definition of the data 

collection item
•	 Justification - Rationale for defining this data collection item. This 

should include any legal mandates or local, regional or national 
requirements

•	 Request Date - Date this catalog item was requested to become a 
data collection item within this project

•	 Approval Date - Date this data collection item was approved for use 
in this project

•	 Effective Date - Date this data collection item becomes effective 
within this project

•	 Retired Date - Date after which this data collection item is no lon-
ger used by this project



How to Catalog a Data Collection Item

1.	 From the INPORT CATALOG TOOLS menu, click on the button 
beside Catalog Editor.

2.	 Select and highlight the appropriate parent Library name in 
the Navigator pane.

3.	 Select and highlight the Catalog Item under which the new 
data collection item will be cataloged.

4.	 Right-click and select menu option New Item or click the Add 
button in the Editor pane.

5.	 In the Catalog Item Type pop-list, select Data Collection 
Item.

6.	 In the Editor pane, fill out the Identification information in the 
Item ID tab.    Starred items are required fields.

7.	 Click on the Data Collection tab and complete the fields that 
can best describe the item that is being cataloged. 

8.	 The user may further document the Data Collection Item us-
ing the various Detail Module tabs that are available for this 
catalog item type.

9.	 Click the Save button.
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Catalog Detail Modules
Detail Modules may be used to describe individual Catalog Items in greater 
detail. For example, a database table (Data Entity) may be described by listing 
its columns (Data Attributes); a Data Collection Item can be further described 
using a Time Frame to define when is was collected and a Procedure for how it 
was collected.

The current list of Detail Modules include:

•	 Support Roles/Contact Information
•	 Geographic Area
•	 Time Frames
•	 Access/Security Info
•	 URLs
•	 Activity Log
•	 Issues 
•	 Technical Environment
•	 Data Quality
•	 Acronyms
•	 Glossary Terms
•	 FAQs
•	 Downloads
•	 Related Items

InPort has been designed to allow for the development of additional Detail 
Modules.  Modules already in development include:

•	 Data Distribution Details
•	 Geospatial Details (for cataloged data products)
•	 Enhanced Technical Environment Details
•	 Enhanced Keyword Module with Keyword Thesauri

Definitions for each item within a given Detail Module can be accessed by 
right-clicking on the canvas area of the Editor pane for the particular tab of 
interest, and selecting Editor Help.

Support Roles Module

Each catalog item support role is significant as a job or responsibility for the data 
described by the catalog item, (e.g., data steward, owner, contributor, etc.).  A 
catalog item Support Role may befilled by a Person or an Organization that has 
been registered within the InPort Catalog.  If a user cannot locate the person or 
organization required for the support role, then the user should report this to 
their InPort Librarian who can complete the registration.



4.23  Catalog Editor - Support Role Tab

Jobs or responsibilities for the data described in the catalog item, including the 
person and organization assigned to that role.

Screen Item Descriptions

•	 Role Begin Date - Role was active starting on this date
•	 Role End Date - Role becomes inactive on this date
•	 Name of person - Name of the person filling the support role
•	 Name of organization - Name of the organization filling the sup-

port role
•	 Contact Instructions - Supplemental instructions on how or when 

to contact the individual or organization
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Geographic Area Module
4.24  Catalog Editor - Geographic Area Tab

Spatial bounds and geographic description of the catalog item.

Screen Item Descriptions

•	 Eastern Boundary - The easternmost longitude in which the data 
was collected.  Use decimal degrees or enter separate integer values 
for position parts (degrees, minutes, seconds) and direction (W/E).

•	 Western Boundary - The western most longitude in which the data 
was collected.  Use decimal degrees or enter separate integer values 
for position parts (degrees, minutes, seconds) and direction (W/E).

•	 Northern Boundary - The northernmost latitude in which the data 
was collected.   Use decimal degrees or enter separate integer values 
for position parts (degrees, minutes, seconds) and direction (N/S).

•	 Southern Boundary - The southernmost latitude in which the data 
was collected.  Use decimal degrees or enter separate integer values 
for position parts (degrees, minutes, seconds) and direction (N/S).

•	 Southern Boundary - The southernmost latitude in which the data 
•	 Geographic Area - The geographic area in which a particular activity 

documented in the metadata record occurred. Include landmass info, 
island groups, ocean sector, etc.

Time Frame Module

Time frame of the data collection event. This may be either a date/time range or 
a single date/time. Multiple Time Frames may be entered to document version 
changes or other events significant to the catalog item.



4.25  Catalog Editor - Time Frames Tab

Date/time of the data collection event.  This may be listed as a single date/time, a 
date/time range, multiple date/times or multiple date/time ranges.

Screen Item Descriptions

•	 Start Datetime Granularity - Date/Time Granularity, e.g., Y(ear), 
M(onth), etc., allows the user to specify the smallest element in the 
data/time string. Y = Year, M = Month, D = Day, H = Hour, I = 
Minute, S = Second, F = Fractional second.  When any level of time 
is specified, the user must specify the time zone.  Example:  includ-
ing time zone: 1987-12-13 12:35 -10:00

•	 Start Datetime - The date/time when the activity described in the 
data collection event record occurred or was initiated

•	 Time Frame Type - Time Frame types: 1) Discrete - a single date/
time measure 2) Range - a date/time period with both start and end 
dates 3) Continuing - has a begin date but no end date

•	 End Datetime Granularity - Date/Time Granularity, e.g., Y(ear), 
M(onth), etc., allows the user to specify the smallest element in the 
data/time string. Y = Year, M = Month, D = Day, H = Hour, I = 
Minute, S = Second, F = Fractional second.  When any level of time 
is specified, the user must specify the time zone.  Example:  includ-
ing time zone: 1987-12-13 12:35 -10:00

•	 End Datetime - The date/time when the activity described in the 
metadata record was completed

•	 Start Event - The activity (e.g., trip number) that signaled the begin-
ning of the activity described in the metadata record

•	 End Event - The activity that signaled the completion of the activity 
described in the metadata.  Example: The data collection ended with 
Trip #1405
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•	 Description - Narrative description of the time frame.  Include the 
time zone, if significant.

Data Access Module

Information about the methods and constraints of accessing the data represented 
by the catalog item.

4.26  Catalog Editor - Access Tab

Details on the restrictions and legal prerequisites for accessing the data. Includes 
any access constraints applied to assure privacy or intellectual property and any 
special restrictions on the use of the data.

Screen Item Descriptions

•	 Security Class - The level of security assigned by the Data Steward 
to this catalog item

•	 Security Classification System - Name of handling restrictions on 
the data set

•	 Security Handling Description - Additional information about the 
restrictions on handling the data set

•	 Access Policy - General description of the policies governing release 
of this data

•	 Access Constraint - Restrictions and legal prerequisites for accessing 
the data set. Includes any access constraints applied to assure privacy 
or intellectual property and any special restrictions on the use of the 
data.

•	 Access Procedure - Narrative description of the steps required to 
obtain access to the data

•	 Metadata Use Constraint - Restrictions and legal prerequisites for 



using the metadata after access is granted. Includes any metadata use 
constraints applied to ensure the protection and privacy of intellec-
tual property, and any special restrictions or limitations on using the 
metadata.

•	 Use Constraint - Restriction and legal prerequisites for using the 
data set after access is granted. Includes any constraints applied to 
ensure the protection of privacy or intellectual property, and any 
special restrictions or limitations on using the data set.

•	 Data Use Constraints - conditions under which the data is provided.

URLs

Catalog Items can be further detailed by pointing to web sites or other internet 
resources.  Each URL listed is a Universal Resource Locator on the WWW 
(e.g., a project web site, a report).

4.27  Catalog Editor - URLs Tab

Internet addresses which may include the path to a file or resource.

Screen Item Descriptions

•	 URL -The complete Universal Resource Locator (web address) 
needed to access the web resource

•	 URL Description - A detailed description of what a user can access 
via the URL

How to Create URLs

1.	 In the CATALOG EDITOR, select the catalog item that will be 
the parent for the URL.
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2.	 Select the URLs tab and enter the URL and URL Description 
for each URL that refers to the selected catalog item. 

3.	 Note that a catalog item may have any number of URLs.  Use 
the Add button to create additional open records if needed. 

Activity Log

Catalog Items can be further detailed by listing activities or events that effect or 
impact the catalog item.

4.28  Catalog Editor - Activity Log Tab

Log of activities and/or events pertinent to the selected catalog item.

Screen Item Descriptions

•	 Date/Time Granularity - Date/Time Granularity, e.g., Y(ear), 
M(onth), etc., allows the user to specify the smallest element in the 
data/time string. Y = Year, M = Month, D = Day, H = Hour, I = 
Minute, S = Second, F = Fractional second.  When any level of time 
is specified, the user must specify the time zone.  Example:  includ-
ing time zone: 1987-12-13 12:35 -10:00

•	 Date/Time - Activity Date/Time or Data/Time part appropriate 
for specified granularity

•	 Activity/Event Type - User supplied activity type
•	 Person - person responsible for this activity or event
•	 Description - text description of the activity or event
•	 Details Button - Click to show record creation and modification 

details of when and who created and last edited this record.
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How to Create an Activity/Event

1.	 In the CATALOG EDITOR, select the catalog item that will be 
the parent for the Activity.

2.	 Select the Activity Log tab and enter the activity/event 
information for each event that refers to the selected catalog 
item. 

3.	 Note that a catalog item may have any number of Activity/
Events.  Use the Add button to create additional open records 
if needed. 
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Issues Module

Each catalog issue is significant as a problem, risk, or question about a catalog 
item.  For example, an issue might be created if a question about a data set’s start 
date exists.

4.29  Catalog Editor - Issues Tab

List of problems, issues, concerns related to the catalog item.

Screen Item Descriptions

•	 Author  - The name for the person reporting the issue
•	 Issue date - The date that the issue occurred or became known
•	 Issue - A detailed description of the issue

Technical Environment Module

Description of the data set in the producer’s processing environment, including 
items such as the name of the software (including version), the computer operat-
ing system, file name (including host-, path-, and filenames), and the data set 
size. (FGDC F1.13).
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4.30  Catalog Editor - Technical Environment Tab

Description of the data set in the producer’s processing environment, including de-
tails such as the name of the software (including version), the computer operating 
system, file name (including host, path, and filenames), and the data size.

Screen Item Descriptions

•	 Technical Environment - A description of the catalog item’s techni-
cal environment, including machine name, software, or other special 
considerations required to use or access the catalog item Access 
Information

Data Quality Module

Details of the quality of the data being documented. These fields are in direct 
support of the FGDC metadata standard.
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4.31  Catalog Editor - Data Quality Tab

Details on usage constraints, completeness, and accuracy of the catalog item.

Screen Item Descriptions

•	 Representativeness - A description of the degree to which the data 
accurately and precisely represents the frequency distribution of a 
specific variable in the population of interest

•	 Accuracy - A description of what is known about the degree of 
agreement between an individual measurement (or the central 
tendency of a number of measurements) to the true value, including 
random (precision) and systematic (bias) error associated with all 
aspects of a measurement system

•	 Analytical Accuracy - A description of the closeness of the values 
derived from the analytical measurement to the true value

•	 Quantitation Limits Measure - The measure of the quantities of a 
target variable that can be quantified with the certainty required by 
the data user

•	 Bias - (Or bias number). A discussion of any systematic or persistent 
distortions in a measurement process that cause errors in one direc-
tion.

•	 Comparability - A description of the confidence that data sets con-
tributing to a common analysis or interpolation were similar

•	 Completeness Measure - The measure that describes the amount of 
usable data obtained compared to the planned amount.

•	 Precision - A description of what is known about the degree of 
mutual agreement among individual measurements of the same 
property under prescribed similar conditions

•	 Analytical Precision Measure - A measure of agreement among 
individual measurements of the same property in duplicate labora-



84	 | 

tory samples
•	 Field Precision Measure - A measure of agreement among measure-

ments of the same property in samples collocated or duplicated in 
the field under prescribed conditions

•	 Sensitivity Measure - The measure of the capability of a method or 
instrument to discriminate between measurement responses repre-
senting different levels of a variable of interest

•	 Detection Limit Measure - The measure that describes the quantity 
of a sample below which the sample analysis equipment will not 
detect the analyte accurately

•	 Completeness Report - Information about omissions, selection cri-
teria, generalization, definitions used, and other rules used to derive 
the data set.

•	 Data Use Constraints - Text commentary on any issues in the use of 
a given data set, including explicit description of any limitations or 
constraints on use of the data

Acronyms

Acronyms used in the context of the project being documented. Acronyms are 
restricted to the project level.

4.32  Catalog Editor - Acronyms

An abbreviation used in the context of a catalog item.

Screen Item Descriptions

•	 Acronym - A shortened name
•	 Meaning - Text definition of the abbreviated acronym
•	 Acronym Type - Valid acronym types are Abbreviation, Short Name, 
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Long Name, Display Name. (This field is not currently used.)

Glossary Terms

Each glossary term is significant as a definition of a word or phrase in the con-
text of the catalog item.

4.33  Catalog Editor - Glossary Terms

List of terms and definitions specific to the catalog item.

Screen Item Descriptions

•	 Term - The glossary word or phrase being defined for this catalog 
item

•	 Authority - The authoritative source of the glossary term’s definition
•	 Definition - The definition of the glossary term within the context 

of the catalog item

FAQs

Each FAQ represents a frequently asked question and answer pair about a cata-
log item (e.g., project, data set).
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4.34  Catalog Editor - FAQs Tab

List of questions and answers that have proven helpful to the understanding and 
use of the catalog item.

Screen Item Descriptions

•	 FAQ Datetime - The date of the FAQ question and answer. De-
faults to system date.

•	 Author - The author of the FAQ question
•	 FAQ Question - The FAQ question related to the InPort catalog 

item
•	 FAQ Answer - The answer to the FAQ question

Downloads

Each download is relevant as a URL to a downloadable file.
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4.35  Catalog Editor - Downloads Tab

List of available downloadable files, images, and documents for the catalog item 
with details and links for obtaining them.

Screen Item Descriptions

•	 File Name - The name of the file to be downloaded. Include the full 
path and file extension if necessary.

•	 File Datetime - Date the file was created
•	 Review Status - A description of the level of review of the file to be 

downloaded. Valid entries include: Not Checked, Metadata Only 
Checked, File Checked for Viruses, File Checked for Inappropriate 
Content, File Checked for Viruses and Inappropriate Content

•	 File Size - In kilobytes, the size of the file to be downloaded
•	 File Type - A description of the type of file that is available for 

download. Valid types include (but are not limited to): PDF, ZIP, 
HTM, DOC, TAR, WK1

•	 Compression Status - The technology used to compress data in 
the file. Valid entries include: Uncompressed, Zip, GZIP, Z, TAR, 
GTAR, Unknown

•	 File Description - A brief description of the character and content 
of the file being downloaded

•	 Download URL - The complete Universal Resource Locator (web 
address) needed to access the file

•	 Connect Protocol - Column not current used
•	 File Path - Column not currently used
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Related Items

It is frequently important to create relationships between catalog items that 
reside in different projects or libraries.  For example, a single data quality docu-
ment can be referenced by several projects, or a Longline Logbook data set 
might be referenced by a Longline Observer data set.  InPort allows users to 
create these user-defined relationships between their catalog items and any 
published catalog items that have a Share Level (see below), that makes them 
available for external linking.  Note that the Share Level is set on the Catalog 
Details tab.

Using Related Items is a powerful way to create virtual metadata folders of 
related data sets.  The user could create a Project catalog item called, for example, 
Highly Migratory Species Data Sets, and then create Related Item links to all 
the available data sets that are relevant to that topic.

There are three possible share levels:

Share Level Description
1 Project Any item in the same Project may link to this item (this is the 

default share level)
2 Library Any item in the same Library may link to this item, once this item 

is published (internal or external)
3 Public Any item in any Library may link to this item, once this item is 

published (internal or external)

4.36  Catalog Editor - Related Items Tab
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User-defined relationship between two Catalog Items.

Screen Item Descriptions

•	 Related Item ID - The InPort ID number of the related item
•	 Related Item Title - InPort Title of the related item. Non-enterable 

field. Field is populated when Related Item ID is entered.
•	 Relationship Notes - Helpful notes describing the relationship of 

this item to the current item

How to Create Related Items

1.	 Using either the CATALOG EDITOR or the INPORT SEARCH, 
locate the catalog item to which you want to link; obtain the 
Catalog Item ID.  (In the CATALOG EDITOR the Item ID is 
found on the Catalog Details tab and in the web search it is 
found in the Catalog Details section at the bottom of the Cata-
log Item Summary page.)

2.	 In the CATALOG EDITOR, select the catalog item that you 
want to link from.

3.	 Select the Related Items tab and enter the Item ID in the next 
available record.

4.	 In the Relationship Notes field, describe the details of the new 
relationship.
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Catalog Publishing Workflow Overview
In InPort, the proces of “publishing” refers to making metadata available to users 
or the public on the InPort web site.  InPort is currently configured with two 
Publication levels - Public/External and Restricted/Internal where only those with 
InPort user accounts may log into the InPort web site to view the metadata.

Each Catalog Item (e.g., a data table or data entity) will be in one of six pub-
lication workflow control states. The workflow control state determines which 
operations may be performed on the catalog item and which InPort User Roles 
may perform those operations. For example, the Published Externally state means 
that users (NOAA and public) can search for and view the catalog item. The 
Draft state means that the catalog item is viewable only by users who have been 
granted access to view or edit that catalog item.

Publication Workflow Control States
•	 Draft - Initial state where most editing occurs
•	 Review/Revise - Metadata is entered and ready for review and final 

editing within this control state
•	 Approved - Metadata has been reviewed and is ready for publica-

tion.  Metadata can no longer be edited without being taken back to 
Review/Revise state

•	 Published-Internal - Metadata is viewable by registered InPort us-
ers. Login required

•	 Published-External - Metadata is viewable by the public. No login 
required

•	 Withdrawn - Metadata was previously published, internally or 
externally, but has been withdrawn

5.  Catalog Publishing



5.1  Allowable Catalog Workflow Control State Changes

Roles

Draft Review Approved Published, 
Internal

Published,
External

Withdrawn

Unless DO NOT 
PUBLISH=Y

(U or W)

(W)

(E)(I)

Published State is indicated by ()

Examples: (U) means Unpublished,
(U or W) means Unpublished or Withdrawn

(U or W)

[SLPA] [SLP] [SLP]

[SLP]
[SLP]

[SLP]

[SLP]

(U or W)

[SLPA] [SLP] [SLP][SLP]

Roles are indicated in [].

Example: [SLP] means that a Sys Admin, Librarian, 
or Publisher can make this state change

Published State

U
I
E
W

--
--
--
--

unpublished (never published)
published internally
published externally
withdrawn

S
L
P
A
R

--
--
--
--
--

Sys Admin
Librarian
Publisher
Author
Reader
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Publication Workflow Rules for Individual Items
5.2  Workflow Control State Rules for an Individual Catalog Item

Control State Description / Primary 
Activity

Allowable Op-
erations

Minimum 
Required 

Role

Next Possible 
Control States

Draft
(Edit)

Entry of metadata Add Child Items
Update
Delete

Read
Move

Change State

Author
Author
Author
Reader
Author
Author

Review/Revise

Review/Revise
(Review)

Review and revision of 
metadata

Add Child
Update
Delete

Read
Move

Change State

Author
Publisher
Publisher
Reader
Publisher
Publisher

Draft
Approved

Approved
(Approve)

Approved for publication Add Child Items
Read

Change State

Author
Reader
Publisher

Published/Internal
Published/External
Review/Revise

Published/Internal
(Publish Internally)

Metadata is made avail-
able to internal - regis-
tered InPort - users who 
can search, review and 
comment on metadata

Add Child Items
Read

Change State

Author
Reader
Publisher

Withdrawn
Publishe/External

Published/External
(Publish Externally)

Metadata is made avail-
able to the public who 
can search, review and 
comment on metadata

Add Child Items
Read

Change State

Author
Reader
Publisher

Withdrawn

Withdrawn
(Withdraw)

Metadata is pulled from 
publication

Add Child Items
Read

Change State

Author
Reader
Publisher

Review/Revise
Approved

Workflow Rules within a Catalog Hierarchy
Under most conditions, users can change the workflow control state for an item 
and all its child items.  The major exception to this is that advancing Catalog Items 
from Review/Revise to Approved is only done on an item by item basis.  This is to 
ensure that every published Catalog Item has been digitally signed off by a Pub-
lisher that the metadata has been reviewed and Approved.

Draft to Review/Revise
•	 When a Catalog Item’s control state is being changed from Draft to 

Review/Revise, the user has the option to change the control state of  
all child catalog items that are also in Draft to Review/Revise

•	 If the user chooses to update the child item’s control state, all chil-
dren that were not in Draft will remain in their current control state.

Review/Revise to Approved
•	 Each Catalog Item must be Approved individually.  This restriction 

is to ensure that each and every catalog item is reviewed and ap-
proved by the Publisher.



•	 However, if the Catalog Item has child items that are in Withdrawn 
state - thus had been previously Published and could never have 
been modified - the user can choose to update any child items that 
are in Withdrawn back to Approved.

Approved to Published (internal or external)
•	 When a Catalog Item’s control state is being changed from Ap-

proved to either Published-Internal or Published-External, the user 
has the option to change the control state of  all child catalog items 
that are already in Approved to the same new Published state.

•	 If the user chooses to update the child item’s control state, all 
children that have Do Not Publish checked will not be moved to 
Published.

•	 If the user chooses to update the child item’s control state, all chil-
dren that were not in Approved will remain in their current control 
state.

Published-Internal to Published-External
•	 When a Catalog Item’s control state is being changed from Pub-

lished-Internal to Published-External, the user has the option to 
change the control state of  all child catalog items that are already in 
Published-Internal to the same new Published-External state.

Published (internal or external) to Withdrawn
•	 When a Catalog Item’s control state is being changed from Pub-

lished-Internal or Published-External to Withdrawn, all child items 
that have been Published-Internal or Published-External will also be 
withdrawn.

Withdrawn to Approved
•	 When a Catalog Item’s control state is being changed from With-

drawn to Approved, the user has the option to change the control 
state of  all child items that are in Withdrawn to Approved.

Approved to Review/Revise
•	 When a Catalog Item’s control state is being changed from Ap-

proved to Review/Revise, the user has the option to change the con-
trol state of all child items that are in Approved to Review/Revise.  
CAUTION:   This action will rescind approval of all child items.  To 
undo this change, each child item must be individually Approved.

Withdrawn to Review/Revise
•	 When a Catalog Item’s control state is being changed from With-

drawn to Review/Revise, the user has the option to change the 
control state of all child items that are in Withdrawn to Review/Re-
vise.  CAUTION:   This action will rescind previous approval of all 
child items.  To undo this change, each child item must be individually 
Approved in order to re-publish.
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5.3  Changing Catalog Item Workflow State in the Catalog Editor

Workflow State can be changed from the Catalog Details tab of the Catalog Edi-
tor using the Metadata Workflow State pop-list.  The available states listed will be 
controlled both by the current state of the catalog item and the InPort User Role 
of the current user per the Catalog Workflow Control State Rules table.

How to Change a Catalog Item’s Workflow Control State

1.	 In the Catalog Editor, select the catalog item in the Navigator 
pane whose control state is to be changed.

2.	 Select the Catalog Details tab.
3.	 Select the desired workflow control state from the Metadata 

Workflow State pop-list.  Note that the available choices in 
this list is dependent upon the role of the user and the current 
workflow state of the selected catalog item.  Refer to the Work-
flow Control States table for details on allowable operations 
and workflow control states.



5.4  Catalog Editor - Catalog Details Tab

The Catalog Details tab controls the publication workflow process and additionally 
allows the user to specify what projects outside the selected catalog item’s top-level 
project can create related links to it (Linking Share Level).

Screen Item Descriptions

•	 Publication Exclusion Flag - Exclude this catalog item and its chil-
dren from publication, Y/N?

•	 Metadata Record Control State - Current metadata workflow state
•	 Record Modified Datetime - Date and time of last record update
•	 Metadata Review Date - The date this (metadata) item should be 

reviewed next
•	 Linking Share Level (who can link to this item) - Scope of use for 

the catalog item:  Public -- any published item in any of the catalog 
Libraries; Library -- any published item in the current Library or 
Project -- any published item in the current Project

How to Edit a Published Catalog Item

1.	 In the Catalog Editor, select the Catalog Item that needs to be 
edited.

2.	 From the Catalog Details tab, change the Metadata Control 
State to Withdrawn.  Note that all published child catalog 
items will also be changed to Withdrawn.

3.	 Change the selected Catalog Item from Withdrawn to Re-
view/Revise, remembering to NOT update any child items to 
Review/Revise.

4.	 Make any needed corrections or additions to the selected 
Catalog Item.
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5.	 Change the selected item’s control state to Approved and 
choose to update any Withdrawn child items to Approved.

6.	 Change the selected item’s control state to Published (internal 
or external, as needed) and choose to update all Approved 
child items to the same new state.
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6.  Catalog Searching

Internal vs. External Publication
Catalog Items that have been Published Internally (that is, published only to 
the InPort user community) can be searched through the InPort web site after 
the InPort user has logged into InPort.  Once logged in, the user will be able to 
search the InPort Catalog and retrieve any items that are either Published-Inter-
nal or Published External

Catalog Items that have been Published Externally can be searched by anyone.  
If an InPort user does not explicitly log into the web site, any search will only be 
made against Catalog Items that have been Published Externally.

Catalog Search Process
•	 User enters a text string in the Search text box and clicks the Search 

button
•	 Search Results Page is displayed showing all published Catalog 

Items that contain the text string in the item’s Title, Abstract, 
Supplemental Information, or Keyword fields

•	 User clicks on a Catalog Item link of interest
•	 The selected item’s Catalog Item Summary Page displayed
•	 User clicks on the Full Details link to display the selected item’s 

Catalog Item Details Page
•	 User can click on any parent, child, and/or related item links on 

the Catalog Item Details page (Catalog Drill Around), to get more 
information about items that are related to the currently selected 
Catalog Item



Text string search
6.1  InPort Home Page Search Box

Enter a text string and click the search button to return a list of items where the 
search string is found in the catalog item’s Title, Abstract, Supplemental Informa-
tion, or Keyword fields.
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Search Results Page
6.2  Catalog Search Results Page

The Catalog Search Results page will list all of the published items that match 
the user’s search criteria.  Click on one of the displayed links to drill down to the 
selected catalog item.  The user may use the search box at the bottom of the Search 
Results page to do a new search.



Catalog Item Details
6.3  InPort Catalog Item Details Page

Clicking on a catalog item link in the Search Results page will display the details 
for this catalog item with all its published metadata.  Use the Quick Links in the 
navigation bar on the left of the page to navigate to specific detail blocks.
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Catalog Hierarchy Drill Around
6.4  InPort Catalog Items Drill Around

The user can use drill up and down the catalog hierarchy by using the parent and 
child item links on the Catalog Item Details page.  The user can also drill over to 
Related Catalog Items if any are defined for the selected catalog item.



Catalog Item Views
The InPort web application allows you to view catalog items in several different 
formats.

Default Web View

The default web view displays the basic information for each Catalog Item, as 
well as the available Detail Modules for that type of Item.

6.5 Catalog Item - Default Web View

Example of the Default HTML view.

A page scrolling navigation bar is available at the top of the page for quick access 
to the various detail modules.

It is possible to drill up and down the Catalog Hierarchy, by clicking on the 
parent link (just above the title of the Item) to go up the hierarchy, or clicking on 
any of the child item links in the Related Items Detail Module.

InPort also provides alternate views of the Catalog Item, available via links at the 
top right of the page:

•	 FGDC View (Data Sets only)

•	 ISO View (Data Sets only)

•	 Metadata Score View (Data Sets only)

•	 Fillable Form View

•	 Printable View
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6.6 Catalog Item - Alternate View Links

Alternate views are accessible via links at the top right of the default web view.

FGDC View

The FGDC View displays Catalog Items as XML metadata records generated 
according to the FGDC Metadata Standard (FGDC-STD-001-1998).

6.7 Catalog Item - FGDC View

Example of the FGDC view  in a browser (Firefox).

Note that not all fields in InPort have an equivalent counterpart in FGDC; 
therefore, the generated FGDC file should not be considered a complete repre-
sentation of the InPort Catalog Item.

The output is a standard XML file, which can be rendered with the browser’s 
XML viewer, or saved to the hard drive for use with other XML tools.
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ISO View

The ISO View displays Catalog Items as XML metadata records generated 
according to the ISO 19139 Geographic Information Metadata XML Schema 
Implementation.

6.8 Catalog Item - ISO View

Example of the ISO 19139 view  in a browser (Firefox).

Note that not all fields in InPort have an equivalent counterpart in ISO; there-
fore, the generated ISO file should not be considered a complete representation 
of the InPort Catalog Item.

The output is a standard XML file, which can be rendered with the browser’s 
XML viewer, or saved to the hard drive for use with other XML tools.
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Metadata Score View

The Metadata Score View applies a scoring rubric to the Catalog Item and dis-
plays the results. The scoring report is used for assessing metadata completeness 
and quality.

6.9 Catalog Item - Metadata Score View

Example of the Metadata Score Report view.
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Fillable Form View

The Fillable Form View displays all Catalog Item information, and the Detail 
Modules available for that type, in a printer-friendly format similar to paper 
forms. It also includes blank fields for all attributes in each Detail Module which 
can be filled in by hand.

6.10 Catalog Item - Fillable Form View

Example of the Fillable Form view.
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Blank Fillable Forms

Blank printable forms are also available on the Publishing page for each type of 
Catalog Item. 

6.11 Blank Fillable Form Links

Links to blank fillable forms for each Catalog Item type are available on the InPort 
Publishing page.

Printable View

Clicking on the “Print This Page” will reformat the page with a layout optimized 
for printing.

Note that this format is intended for reading; if you would like to fill in blank 
fields or annotate your print out, the Fillable Form View is recommended in-
stead.
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Advanced Search
6.12 InPort Advanced Search Page

The user can use the Advanced Search options to refine their search results based 
on temporal and spatial bounds or catalog item type.

Rules that will make your InPort search more effective:

Search Terms

Fields searched: Title, Abstract, all keywords fields

•	 Search terms are not case sensitive (i.e., CAT is the same as cat is the same as 
Cat)

•	 Multiple search words should be separated with a space; multiple search 
words will be “ANDed”. Example: If you enter effort catch regulation, only 
catalog items containing the words effort and catch and regulation will be 
found.

•	 Special characters including  * ( ) ? [ ] , & $ ! ~ = + . < > / cannot be used in 
searches. However, an underscore (e.g., trip_num) or an embedded hyphen 
(e.g., two-sided) can be used.
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•	 Partial words (e.g., statist, informa) will not be found. Wildcard characters 
are not available for word completion and will cause an error if used.

•	 You may use single or double quotes around a phrase (the phrase may not 
contain special characters)

•	 Certain words are reserved  and will cause an error if used (e.g., and, or)

•	 Certain words are ignored  and will not be found (e.g. not, the)

Catalog Item Type

•	 1)	 You may narrow your search by selecting one or more catalog item 
types.

Examples: 

•	 Click on Document to limit your search to documents only

•	 Hold the Shift Key and click on Project and Data Set to limit your search to 
projects and data sets

•	 To search all catalog item types, select All

Timeframe

Fields searched: timeframe start date and timeframe end date

You may narrow your search as follows:

•	 Enter a Start Date. You must enter at least the year (month may be blank). If 
the catalog item 

•	 Enter a Date Range (Start Date and End Date). Any dates falling within the 
date range will be found

Geographic Area

•	 Enter numbers in decimal degrees. Use a minus sign (“-“) for latitudes south 
of the Equator and longitudes east of the Greenwich Meridian (but west of 
the International Date Line)

Combining Search Criteria

Search criteria (Search Words, Type, Timeframe, Geographic Bounds) may be 
combined.

Examples: 

•	 Enter Search Words plus a Timeframe

•	 Enter Search Words plus a Type

•	 Enter Search Words plus Type plus Timeframe plus Geographic Bounds

Note that when the search is performed, the search criteria are “ANDed”.
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7.  Metadata Score Report

Overview
The Metadata Score Report displays the result of applying a metadata quality 
scoring rubric to a Data Set Catalog Item. The scoring rules are determined by 
NMFS for the purpose of promoting quality metadata.

The report can be accessed by searching for or navigating directly to a Catalog 
Item in the web application. A link to the report will be available at the top right 
of the Catalog Item view.

7.1 Catalog Item - Metadata Score Report Link

Click on the Metadata Score Report link to access the report.

Report Contents
The report consists of an overall score display, followed by individual scores for 
each scoring area. Scores are displayed as a percentage of rules passed, as well as a 
raw numeric score.

7.2 Metadata Score Report - Overall Score

The Metadata Score Report displays an overall score breakdown of each area.

The current scoring areas are:

•	 Identification

•	 Spatial/Temporal Extents
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•	 Contacts/Citation

•	 Data Set

Each rule shows the attribute it applies to, a description of the attribute, and the 
best practice associated with the attribute. A path is also displayed to help locate 
the attribute in the InPort Catalog Tools Editor, an FGDC file, or an InPort 
XML file.

7.3 Metadata Score Report - Scoring Area

Each scoring area displays the score and the result of each rule when applied to the 
current Catalog Item.

Identification Score
This scoring area encompasses the metadata fields for identification and dis-
covery of the metadata, including fields such as the metadata identifier, title, 
abstract, purpose, theme keywords, and place keywords.

Spatial/Temporal Extents Score
This scoring area encompasses the metadata fields dealing with spatial or tem-
poral extents, such as the geographic area (expressed as coordinates or a textual 
description), status, and time frames of the data collected.

Contacts/Citation Score
This scoring area encompasses the metadata fields dealing with contact informa-
tion and metadata citation information. It includes fields such as the originator, 
point of contact, metadata contact, and publication date.
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Data Set Score
This scoring area encompasses data set information fields for the metadata, such 
as the security class, data access constraints, data use constraints, technical envi-
ronment, completeness report, and accuracy.

View Options
You can quickly scroll from section to section using the navigation toolbar at the 
top of the page.

7.4 Metadata Score Report - View Options

The report view options allow quick navigation to each score area, as well as control 
over the display of various aspects of the rules.

A number of view options can also be applied by hovering your mouse over 
the Options menu  at the top right of the page. These options help to filter the 
report for specific information, and can be useful for formatting the report for 
printing:

•	 Paths – show or hide the paths to the attribute for each rule

•	 Best Practices – show or hide the best practices for each rule

•	 Only Missing Attributes – show only the attributes that are missing
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8.  Metadata Upload

InPort allows metadata created externally to be uploaded as data sets into InPort. 
Currently, InPort accepts all files which confirm to the FGDC metadata stan-
dard.

The FGDC metadata standard provides a common set of terminology and definitions 
for the documentation of digital geospatial data.

Uploading Metadata
To begin the metadata upload process, login to InPort and click on Publish in 
the main navigation bar. After the InPort Publishing page has loaded, click on 
the link called Metadata Upload.

8.1 Publishing Page – Link to Metadata Upload

Click on the Upload Metadata link on the InPort Publishing page to start the 
upload process.

Step 1: Select Project

InPort will display a list of all the projects you have access to in the Catalog. If 
you do not see the project you want to upload metadata into, please contact your 
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Librarian to be granted access.

 The report consists of an overall score display, followed by individual scores for 
each scoring area. Scores are displayed as a percentage of rules passed, as well as a 
raw numeric score.

8.2 Metadata Upload – Select Project

Select the project to load the metadata into from the list of available projects.

All data sets must belong to a project; consequently, the first step is to select the 
project you would like to upload your metadata into.

When you have found the desired project, click on the Select button to the right 
of the project name.
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Step 2: Upload File

The next step is to upload the metadata file for validation. The file must meet the 
following requirements:

•	 It must be a valid XML file.

•	 It must be encoded in either the ISO-8859-1, UTF-8 or CP1252 char-
acter set. (If you don’t know what encoding your metadata uses, it’s not usually 
something to be concerned about. It’s rare to have metadata in another character 
set other than these three).

•	 It must conform to the FGDC standard.

Note that the FGDC specification requires dates and times to be formatted 
according to the ANSI 1986 standard. For example, the following are valid date 
and time values:

ANSI Date/Time Format Means

2010 The year 2010
201005 May 2010
20100501 May 1, 2010
20100501T1000 May 1, 2010, 10:00 AM Local Time
20100501T1000+0100 May 1, 2010, 10:00 AM (+1:00 

GMT)

8.3 Metadata Upload – Choose File

Click Browse to select the file to upload from your hard drive.

Click on the Browse button to locate the file, and then click Upload to transmit 
the file to the server.
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Step 3: Validation Check

Before metadata can be added to InPort, it must pass a validation check. Note 
that this validation is only for the purposes of uploading into InPort. It does 
not, for example, ensure that the file is a valid FGDC file (MERMAid is one 
example of a tool can be used for FGDC validation).

8.4 Metadata Upload – Validation Report

The validation report shows a list of any errors and warnings found in the meta-
data, as well as options on what to do next.

The validation check will result in a list of errors and warnings. A link to display 
a plain text validation report is also provided, to make it easier to copy the list of 
issues into an email or text file.

There are 2 different types of issues that can be found:

1.	 Errors are significant issues which prevent the data set from being add-
ed to InPort. These issues must be corrected before the metadata can be added.

2.	 Warnings are less serious issues that indicate a potential problem with 
the metadata, but do not prevent it from being added to InPort. However, it is 
strongly recommended that you review these issues, as InPort may make modifi-
cations to the metadata in order to make it conform to its own model.

If any errors are found, you will not be able to add the metadata to InPort as is. 
Correct the metadata file on your computer first, then click the Upload Again 
button to return to Step 2.
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If there are warnings, but no errors, you can choose to add the metadata as is 
to InPort. Or, you can make changes to the original file and click the Upload 
Again button to try again.

To add the uploaded metadata to InPort, click on the Add to InPort button.

Viewing the Newly Added Data Set

After your metadata has been added to InPort, you can click on the View Item 
in InPort button to review the metadata added as it is stored in InPort.

8.5 Metadata Upload – Data Set Added Successfully

Successful addition of a new data set into InPort. The new item can be viewed in 
InPort, or more files can be uploaded.

If you have more data sets to add, click on the Upload Another File button to 
upload the next file.
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9.  Catalog Batch Loading

Interface to Oracle Databases
InPort can load some entity and attribute information from the data dictionary 
of an Oracle database. This information includes table and column names, data 
types and sizes, and comments.

The interface was created because many of the databases relevant to NMFS cur-
rently use Oracle.

The interface between InPort and the Oracle database runs in four stages.



Stage 1 - Creating the Extract File (10g R2 or later)
In this stage, you will create an extract from table definitions in an Oracle data 
dictionary.  These instructions apply to Oracle databases version 10g, Release 2 
or later. Earlier versions of Oracle require a much more complex procedure than 
this, described later.

Instructions
Step 1:  Download the extract script.

The extract script is available from: 
https://inport.nmfs.noaa.gov/inport/downloads/inport_extract.sql

Step 2:  Customize the script.

If there are any tables or views that you do not want included in the extract, edit 
the line at the start of the script to add these to the “:exclude_tables” bind vari-
able.

Name those tables as a comma-separated list. The whole list should be enclosed 
in single-quotes.

If a table name contains spaces or lowercase, then that individual table name 
must be enclosed in double quotes. 

Note that the list is initially populated with the name ‘INPORT_EXTRACT_
TEMP’. This is the temporary table that the script creates, and is deleted when it 
is done.

Step 3:  Run the script.

From there you connect to the database with sql-plus, as the Oracle user that 
you wish to extract as.

Run the script. It will ask for a simple name, used to construct the output file 
names. It will produce a pair of output files in the same folder: 

	 a) XXX-extract.lis will contain the extract report

	 b) XXX-qa.lis will contain the quality-assurance report

(where XXX is the name you supplied)

Go on to Stage 2.

Stage 1 - Creating the Extract File (before 10g R2)
In this stage, you will create an extract from table definitions in an Oracle data 
dictionary.  These instructions apply to Oracle databases version 8i, 9i, and 10g 
Release 1. If you are using Oracle 10g Release 2 or later, please refer to the previ-
ous section.

Prerequisites
•	 The Application runs on an Oracle8i/9i/10g Release 1 database
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•	 You (or an available DBA) have the ability to create a new username, 
grant select privileges to DBA_ views, and modify views.

Instructions
Step 1:  Download and unzip the extract scripts

The extract scripts are available from https:// inport.nmfs.noaa.gov/inport/
downloads/InPortExtract.zip

Step 2:  Pick an Oracle user account to run the extract script, and run inpx1.sql. 

We recommend creating a single username (e.g., INPORT_USER) in a data-
base to use for InPort extracts.

As SYS, run inpx1.sql to grant the required privileges to the username.
SQL> @inpx1.sql
Enter the username that will be used to run the In-

Port extract.
InPort Extract Username: INPORT_USER

Step 3:  Run inpx4.sql (QA Report) 

See Appendices for notes on how to change directories in SQL*Plus (Win-
dows).

Login as the user selected in Step 2, and run inpx4.sql. The script requests the 
application name, which is used to generate a name for the output file, <app-
name>-qa.lis.

SQL> connect INPORT_USER/password
Connected.
SQL> @inpx4
…
Enter value for appname: MYAPP
Review the output file, MYAPP-qa.lis. Correct and 

update application table and column comments as 
needed.

Step 4: If necessary, modify inpx2.sql to include or exclude tables. Rerun inpx4.
sql and review missing comments.

Inpx2.sql defines a view inport.my_tables_views_v that should return one row 
for every table and view you want to include in the extract.

If you modify inpx2.sql, be sure to save changes, as other scripts use this file.

Step 5:  Run inpx5.sql
SQL> @inpx5
Enter a short application name code.
It will be used as a prefix for output file names.
Example: Application name INPRTDV
Outputs: INPRTDV-qa.lis will contain missing comments 

report
INPRTDV-extract.lis will contain the extract report
Application Name: MYAPP
…

Inpx5.sql will create the extract file MYAPP-extract.lis.



Stage 2 - Uploading the extract file

In this stage, you will copy the extract to staging tables in an existing InPort 
Catalog Project through the Batch Extract Upload feature on the InPort web-
site.

Prerequisites
•	 You must be an authorized Librarian, Publisher, or Author.
•	 You must have access to a Project with a Data Set that the extract 

will be loaded into.

Instructions
Step 1: Login to the InPort Website

Go to InPort Website at: https://inport.nmfs.noaa.gov/inport and click on the 
Login link to login.

Step 2: Navigate to the Batch Extract Upload page.

After logging in, click on the Publish link in the navigation bar. Then, click on 
the page link, Batch Extract Upload.
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9.1  InPort Batch Upload Page

The InPort Batch Upload page should list all catalog Projects accessible to the 
currently logged in user.  If the list does not include the desired target Project, 
then the user or his/her catalog Librarian will need to create the Project using the 
Catalog Editor tool.  Clicking on the Batch Upload button will open the Batch 
Load page where the user can select his/her file for batch loading.

Step 3: Select the Project to upload to 
           From the list of available projects, select the desired Project to upload into 



by clicking the corresponding Select button.

If you do not see the Project in the list, contact your Librarian to ensure you have 
the appropriate access.

Step 4: Upload the extract file

Enter a name for the upload. We recommend including the name of the da-
tabase and the extract date, e.g., PIR Observer, 4/15/05. You may also add any 
additional notes in the Comment field.

Click on the Browse button to locate the extract file on your hard drive. Then 
click the Upload button.

9.2  Batch Upload Page

Clicking on a Select button for a catalog Project from the InPort Batch Upload 
page, opens the Batch Upload page where the user can choose and describe a file 
from his/her local system for batch loading into the InPort staging tables.
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Step 5: Confirm the extract file has been uploaded

After clicking Upload, the page should reload, and the uploaded file should ap-

pear in the table at the top of the page, with status “Loaded.”

Stage 3 - Edit/Validate the Upload Batch File
In this stage, you will validate the table/column specifications in the file you 
uploaded, and make any necessary corrections.

Prerequisites
•	 You must be an authorized Librarian, Publisher, or Author.

Instructions

Step 1: Launch the InPort Catalog Tools application.

From the InPort Website Publishing page, click on the link, InPort Catalog 
Tools, and login to the application.

Step 2: Navigate to the Table/Column Loader

Click on the Table/Column Loader button.

Step 3: Specify the batch upload file to validate.

On the Validate tab, select the name of the desired batch upload file from the 
Select Loaded File dropdown list. Then click on the Validate button.



9.3  Table/Column Loader Tool - Validate Tab

Use the Validate tab on the Table/Column Loader tool to select a loaded batch file 
and run validation on it.

Step 4: Review the file.

Click on the Edit tab and select a file to Review/Edit. Then use the dropdown 
list labeled Select Items to Review/Edit to choose which items to edit (all or 
only errors on tables or columns).

Edit the entity/attribute (table/column) information as needed. 

Step 5: Save changes and verify.

Click Save when you are done. If validation failed, repeat the Validation steps.

130	 |  Catalog Batch Loading



	 InPort Catalog v 2.0 User Guide 03.22.2012  |     131

9.4  Table/Column Loader Tool - Edit Tab

Use the Edit tab to review and/or revise the table and column (entity/attribute) 
information that is in the staging tables.  Remember to re-run validation after 
saving any changes.

Stage 4 - Copy Batch File to InPort Catalog
In this stage, you will copy the validated contents from the staging tables into 
the InPort Catalog.

Prerequisites
•	 You must be an authorized Librarian, Publisher, or Author.
•	 An InPort Data Set has been created under the appropriate Project 

item to hold the entities and attributes (tables and columns).



Instructions
Step 1: Select the validated file.

In the Table/Column Loader tool, click on the Catalog tab. Select the file vali-
dated in Stage 3 from the Validated File dropdown list. If you are re-importing 
batch data, use the Previously Cataloged File dropdown instead.

Step 2: Select the Data Set that you will copy into.

Select a Catalog Data Set from the dropdown list.

Step 3: Import the data.

Add any additional notes if desired, then click on the Import button.

Step 4: Review the imported contents.

You can use the InPort Catalog Editor tool to review the contents of the Data 
Set and to complete the InPort publication process for the new tables and col-
umns.

9.5  Table/Column Loader Tool - Catalog Tab

Use the Catalog tab to import the Entity type Catalog Items based on the data 
in the validated batch file.  The selected Data Set will be the parent catalog item 
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of the new Entities.  The Notes field will show a history of the loading process. 
Clicking on the Import button will copy the contents of the staging tables into 
the selected catalog Data Set.  This tab can also be used to re-import or refresh the 
table/column information from the batch load.

How to Re-import Batch data into the InPort Catalog

1.	 In the Table/Column Loader tool, select the Catalog tab.
2.	 Select a Previously Cataloged File from the pop-list
3.	 Select a Catalog Data Set from that pop-list.
4.	 Add any additional comments in the Notes field as needed.
5.	 Click the Import button.
6.	 Use the CATALOG EDITOR tool to review the contents of the 

Data Set and to complete the InPort publication process for 
the new tables and columns.
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Appendix A - Glossary of Terms

General Terms
The following list contains definitions of some of the terms used within the 
InPort metadata catalog system.

Catalog Batch Loading - InPort can load some entity and attribute information 
from the data dictionary of an Oracle database. This information includes table 
and column names, data types and sizes, and comments.

Catalog Hierarchy - Catalog items may be organized in a hierarchy that defines 
the parent-child relationships between catalog items. Each catalog item may 
belong to one-and-only-one parent catalog item. Each catalog item may be the 
parent of one or more catalog items. Each catalog item may not be the parent of 
itself. There are specific rules about which catalog item types may be children of 
other catalog item types (see InPort User Guide for details).

Catalog Item - A searchable record that describes fisheries dependent or inde-
pendent information of significance to NOAA Fisheries. There are nine types of 
catalog items: Projects, Data Sets, Data Entities, Documents, Domains, Proce-
dures, Models, and Data Collection Items

Catalog Item Identification - Basic information about the identification, pur-
pose, and location of the catalog item

Catalog Workflow Control - Each Catalog Item (e.g., a data table or data entity) 
will be in one of six publication control states. The publication control state 
determines which operations may be performed on the catalog item and which 
InPort User Roles may perform those operations.

Data Standard - Information that defines a standard method of storing, manag-
ing, and using a specified type of data in a database

Detail Module - Detail Modules may be used to describe individual Catalog 
Items in greater detail. For example, a database table (Data Entity) may be 
described by listing its columns (Data Attributes); a Data Collection Item can 
be further described using a Time Frame to define when is was collected and a 
Procedure for how it was collected.

Event History - List of events relating to the catalog item, including dates, event 
descriptions and persons involved

InPort Author - InPort User Role that allows the person to create and edit 
metadata in their assigned InPort Library while the metadata is in Draft state

InPort Catalog - the collection of InPort Libraries that contain the metadata for 
cataloged information items.



InPort Data Steward - InPort Data Stewards have the same catalog privileges as 
an InPort Reader but have the ultimate responsibility of authorizing or rejecting 
InPort Catalog Access Roles for their InPort Library.

InPort Librarian - An InPort Librarian can create and manage catalog Persons 
and InPort user accounts for their Metadata Library. Librarians can create and 
manage catalog project access requests, authorizations and rejections. Librarians 
create new organizations under their Organization and can create and manage 
catalog project folders under their Metadata Library.

InPort Library - an organization’s Metadata Project. The Inport Catalog con-
tains many InPort Libraries.

InPort Organization - Organization unit or business or professional entity (e.g., 
division, department, etc.) that is registered in the InPort Catalog

InPort Person - A person that is registered in the InPort Catalog. People that 
serve in data support roles for catalog items and/or InPort User Roles are re-
quired to be registered in InPort

InPort Publisher - InPort Publishers manage the review of metadata and ensure 
that quality assurance processes are completed. Publishers should give feedback 
and advice to InPort Authors on metadata quality and sufficiency. Publishers are 
responsible for web publication, either internally or externally, and for withdraw-
ing metadata for correction or further review. Publishers will monitor metadata 
issues activity and ensure that issues resolution occurs in a timely fashion.

InPort Reader - InPort Readers review catalog items through the Catalog 
Editor or log onto the InPort web site to search and view internally published 
catalog items. Readers do not have any edit abilities. Readers are responsible for 
reporting any metadata issues.

InPort User Role - The privileges and responsibilities of an InPort user within 
the InPort Catalog and/or InPort Libraries and Projects. Current roles include 
InPort Administrator, InPort Librarian, InPort Author, InPort Publisher, InPort 
Data Steward, and InPort Reader

Organization Assignment - Controls the InPort Libraries in which an InPort 
Person may be granted InPort User Roles

Published-External - Catalog items published to the general public and are 
available in InPort web search.

Published-Internal - Catalog items published in a restricted mode and available 
in InPort web search to InPort Users that are currently logged into the InPort 
web site.

Record Details - Auditing details (date of change, changed by) for a given record

Catalog Item Types
The following is a list of the major types of objects for which metadata is col-
lected in InPort. The acronym (in brackets) is used in the search results to denote 
the type of the catalog item.

Project [PRJ] - project type catalog items can be thought of as metadata folders. 
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A Project folder might, indeed, describe a real-life data project, it might also be 
used as a convenient way to describe a set of related items under which each of 
the collected items may be cataloged.

Data Set [DS] - a catalog item of type Data Set can describe a Database, a 
collection of related data Files, or a user defined collection,as described in its 
Abstract.

Data Entity [DE] - a catalog item of type Data Entity can describe a data table, 
a data file, a data report, a spreadsheet, a data entry form with data, an xml file, or 
other user defined information item that itself contains data attributes (columns 
or fields). Data Entities are most frequently thought of as Tables. Data Entities 
normally are child items of a catalog Data Set.

Document [DOC] - any existing document that relates to the parent catalog 
item. If a document contains data, and thus needs to be described with proce-
dures or attributes, then it should probably be cataloged as a catalog type Data 
Entity.

Procedure [PRC] - a procedure, protocol, or process that is relevant to the par-
ent catalog item

Data Collection Item [DCI] - the description of the collection of a specific 
type of information within a data collection project/effort, such as trip number, 
sea-surface temperature, and hook type. A well documented data collection 
system will include information on the history, purpose, collection methods, and 
business rules for each type of information, or data collection item, which is col-
lected.

Detail Modules
The following is a list current “detail modules” collected for items cataloged in 
the InPort:

Acronyms - An abbreviation used in the context of a catalog item

Data Access - Details on the restrictions and legal prerequisites for accessing 
the data. Includes any access constraints applied to assure privacy or intellectual 
property and any special restrictions on the use of the data

Data Attribute - A piece of data collected and stored in a table, field, cell, or 
form or a calculated value. Data attribute records always reside under a Data 
Entity parent item.

Data Quality - Details on usage constraints, completeness, and accuracy of the 
catalog item

Downloads - List of available files, images, and documents for the catalog item 
with details and links for obtaining them

FAQs - List of questions and answers that have proven helpful to the under-
standing and use of the catalog item

Geographic Area - Spatial bounds and geographic description of the catalog 
item.

Glossary Terms - List of terms and definitions specific to the catalog item



Issues - List of problems, risks, or questions about a catalog item

Related Items - List of catalog items that have a user defined relationship to 
another catalog item

Support Roles - List of people and organizations with jobs or responsibilities for 
the catalog item

Technical Environment - Description of the data in the producer’s process-
ing environment, including details such as the name of the software (including 
version), the computer operating system, file name (including host, path, and 
filenames), and the data size

Time Frames - List of temporal limits of the catalog item which can be based 
on either time/date or an event, (e.g., trip)

URLs - List of internet addresses that are relevant to the catalog item
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Appendix B - InPort Architecture

C-1  FIS InPort
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InPort has been identified as a core tool for developing the National Fisheries 
Information System.



C-2  InPort Technical Overview

Fisheries Information System

Other FIS 
Applications

InPort
Repository & 
Web-site

Application Server(s)
Unix

App Server 10g (9.0.4.x)

Database Server(s)
Unix

Oracle9i 9.2.0.5

InPort site: 
JSP, Apache, 
Forms,
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InPort DB 
(XML,
Oracle Text)

FIS Portal

Other Metadata 
Systems (e.g., NBII)

Secure Network

InPort
Query Users

InPort
Publishers

Internet / 
WWW

InPort Technical Environment
•	 Designed to run in the FIS technical environment
•	 FIS technical environment 
•	 Database – Oracle9i (9.2.0.5)
•	 Application Server – 10g (9.0.4)

Major Components
•	 Search and Retrieve Published Catalog Items ( JSP, PSP)
•	 Data Entry and Publication (Oracle Forms 10g)
•	 Database (Oracle9i, XML, Oracle Text)
•	 Interfaces (Inbound / Outbound)

Search and Retrieve
•	 JSP, Apache Web application

Simple Search
•	 Searches all published catalog items
•	 Enter one or more search words. Search results include any item that 

matches ALL search words.
•	 Uses Oracle Text Context indexes

Internal/External Search
•	 Internal searches cover Catalog Items published Internally (to FIS 

Partners). This requires a login. Results are encrypted over HTTPS.
•	 External searches cover Catalog Items published Externally. These 

are publicly available.
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Future: Advanced Search
•	 Search of individual fields or keywords
•	 Use Oracle Text for complex searches

Data Entry and Publishing
•	 Oracle Forms (9.0.4) 
•	 Requires users to download and install Jinitiator
•	 Runs over HTTPS 

Main Applications
•	 Library Manager – Administrative functions
•	 Catalog Editor – Metadata entry, maintenance and publishing of 

catalog items and catalog hierarchy

Database

Uses Oracle XML API
•	 To generate XML docs in response to Search queries

Uses Oracle Text
•	 To support searches of eight fields: 

•	 Title
•	 Name
•	 Abstract
•	 Notes
•	 Theme Keywords
•	 Place, Keywords
•	 Temporal Keywords
•	 Stratum Keywords

•	 Future
•	 Use controlled thesauri for keywords
•	 Expand InPort us of the Context search engine

Basic Design
•	 Catalog uses a hierarchical design
•	 Catalog Related Items allows reference links between one catalog 

item and another. Reduces redundancy.
•	 PL/SQL APIs for most complex data manipulation and retrieval
•	 View layer for all Forms and Web access

InPort Interfaces

Outbound
•	 Search results are XML docs
•	 Future: More  XML documents

Inbound
•	 Flat file upload of Oracle8i/9i/10g data dictionary extracts
•	 Future: XML based exchange format
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Appendix C - National Fisheries Information System

National Fisheries Information System

FIS was first described in broad terms in section 401 of the Magnuson-Stevens 
Act (1996 amendments). FIS was described in more detail in the Proposed 
Implementation of a Fishing Vessel Registration and Fisheries Information 
System [7].

Some of the major objectives of FIS are a standardization of critical information 
(e.g., vessel, gear, regions, effort, trips, and time), non-duplicative integration, 
timely reporting, and confidentiality. It is also supposed to minimize the paper-
work burden on fishermen.

D-1  FIS Model
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The proposed FIS model is founded on the development of information manage-
ment standards and data quality standards that will allow timely integration and 
analysis of Fisheries Dependent data.
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Appendix D - InPort Authorization Forms

Forms for registering and authorizing InPort Organizations, Libraries, and Per-
sons are found on the following pages.





Organization

Organization Name

Org. Type

Authorizer's Signature

Acronym

Description

Street Address

City

State/Province Postal Code

Country

Phone

URL

Business Hours

InPort Library Request Form

Library

Library Title

First Name Last Name

InPort Data Steward (full information should be provided on the InPort Person Registration Form)

InPort Librarian (full information should be provided on the InPort Person Registration Form)

Email Address

Email Address

Last NameFirst Name

By signing this request for an InPort Library, the InPort Data Steward for the above specified organization agrees to  NOAA and NOAA
Fisheries policies and guidelines with regard to Internet activities, computer account passwords, and data quality.

Date

Phone

Phone

NOAA Fisheries
National Fisheries Information System
InPort Metadata Catalog (tel 808-983-5387, fax 808-9832922)

Please complete all fields on this form per instructions on the back of this form.

Authorizer's Role
inp_lib_form v. 051129



The InPort Library Request form must be completed and signed by the organization's authorizing agent (director, IT manager, etc.), and fax'ed or mailed to the InPort
Administrator along with completed and signed InPort Person Registration forms for  at least one InPort Data Steward and one InPort Librarian for the requested Library.

Organization
Organization Name - the name of the organization
Acronym - an acronym of the organization
Organization Type - the selected organization type.  [FIS (FIS Partner), FRO (Fisheries Regional Office), FSC (Fisheries Science Center)]
Description - a description of the organization
Street Address - the street address of the organization, including Suite# or P.O. Box
City - the city where the organization is based
State/Province - the state or province where the organization is based
Postal Code - the zip or postal code of the organization
Country - the country where the organization is based
Phone - phone number
URL - a Universal Resource Locator that can be used to reach the organization via the Internet
Business Hours - business hours of opertation

Library
Library Title- the proposed title of the new InPort Library

InPort Data Steward
Last Name - last name of the person
First Name - first name of the person
Email Address - contact email address
Phone - contact phone number

InPort Librarian
Last Name - last name of the person
First Name - first name of the person
Email Address - contact email address
Phone - contact phone number

Authorization
Authoirizer's Signature - signature of the individual authorizing this form[Director, IT Manager,, etc.]
Date -date the authorizer signed this form
Authorizer's Role - role that entitles the signer to authorize this form [Director, IT Manager, etc.]

Instructions for Completing the InPort Library Request Form

back - inp_lib_form v. 051129

Organization

Person Contact Information

Name

Authorizer's Signature

Building Name

City

State/Province Postal Code

Country

Business Hours

InPort Person Registration Form

First NameLast Name

Person

Employment Information

Email Address

Work Location

Expertise

Mgr. User ID

By signing this InPort Person Registration Form, the InPort Data Steward authorizes the specified person to execute the responsibilities of the indicated InPort User Role
within his/her organization's InPort Library.

Date

Routing Code

NOAA Fisheries
National Fisheries Information System
InPort Metadata Catalog (tel 808-983-5387, fax 808-9832922)

Street Address

Room Number

Mailing

Physical

Address Type

Business

Residence

Location Type

Role Data Steward Librarian Publisher Author Reader Support Only

Honorific  Mid. Inits.  Name Inits.

Contact
Instructions

Voice Tel.

FAX Tel.

NOAA User ID

Job Title

Employer Emp. Type

Org. Acronym

DateInPort Person's Signature

By signing this InPort Person Registration Form, the InPort Person agrees to abide by NOAA and NOAA Fisheries policies and guidelines with regard to Internet activities,
computer account passwords, data quality, and the responsibilities of his/her InPort User Role.

Authorizer's Role

Please complete all fields on this form per instructions on the back of this form.

inp_pers_form v. 051129



Organization

Person Contact Information

Name

Authorizer's Signature

Building Name

City

State/Province Postal Code

Country

Business Hours

InPort Person Registration Form

First NameLast Name

Person

Employment Information

Email Address

Work Location

Expertise

Mgr. User ID

By signing this InPort Person Registration Form, the InPort Data Steward authorizes the specified person to execute the responsibilities of the indicated InPort User Role
within his/her organization's InPort Library.

Date

Routing Code

NOAA Fisheries
National Fisheries Information System
InPort Metadata Catalog (tel 808-983-5387, fax 808-9832922)

Street Address

Room Number

Mailing

Physical

Address Type

Business

Residence

Location Type

Role Data Steward Librarian Publisher Author Reader Support Only

Honorific  Mid. Inits.  Name Inits.

Contact
Instructions

Voice Tel.

FAX Tel.

NOAA User ID

Job Title

Employer Emp. Type

Org. Acronym

DateInPort Person's Signature

By signing this InPort Person Registration Form, the InPort Person agrees to abide by NOAA and NOAA Fisheries policies and guidelines with regard to Internet activities,
computer account passwords, data quality, and the responsibilities of his/her InPort User Role.

Authorizer's Role

Please complete all fields on this form per instructions on the back of this form.

inp_pers_form v. 051129



Instructions for Completing the InPort Person Registration Form

The InPort Person Registration form must be completed for any person requiring the Data Steward or Librarian InPort User Role and is to be signed by both the person and
the organization's authorizing agent (director, information manager, etc.).  The signed form for either a Data Steward or Librarian must be fax'ed or mailed to the InPort
Administrator.

Additionally, InPort Librarian's may use this form to register  and/or assign InPort User Roles of type Reader, Author, and Publisher and have those authorized by the
organization's InPort Data Steward (InPort Librarians would maintain these completed forms for their own records and do not need to submit them to the InPort
Administrator as it is the InPort Librarian that registers and assigns InPort User Roles of those types.)

Organization Information
Name - the name of the organization

InPort User Roles

InPort Librarians - An InPort Librarian can create and manage catalog Persons and InPort user accounts for their Metadata Library.  Librarians can create and manage catalog
project  requests, authorizations and rejections.  Librarians can create new organizations under their Organization and can create and manage catalog project folders under
their Metadata Library.

InPort Data Stewards - InPort Data Stewards have the same catalog privileges as an InPort Reader but have the ultimate responsibility of authorizing or rejecting InPort User
Roles.

InPort Publishers - InPort Publishers manage the review of metadata and ensure that quality assurance processes are completed.  Publishers should give feedback and advice
to InPort Authors on metadata quality and sufficiency.  Publishers are responsible for web publication, either internally or externally, and for withdrawing metadata for
correction or further review.  Publishers will monitor metadata issues activity and ensure that issues resolution occurs in a timely fashion.

InPort Authors - InPort Authors enter, review, and correct metadata that is in a Draft state in the Library or catalog Project for which they have been granted a  role.  Authors
have authority to put metadata into Review/Revise state at which point the Author will no longer have edit capabilities.  Authors are responsible for requesting publication
review for that metadata from their Catalog Publisher.

InPort Readers - InPort Readers review catalog items through the Catalog Editor or log onto the InPort web site to search and view internally published catalog items.
Readers do not have any edit abilities.  Readers are responsible for reporting any metadata issues.

Person Information
Honorific - title of respect [Mr., Ms., Mrs., Rev., Dr., The Honorable, etc.]
Last Name - last name of the person
First Name - first name of the person
Mid. Inits. - middle initials of the person
Name Inits. - initials of the person
Email Address - contact email address
Contact Instructions - instructions on how best to contact the person
Business Hours - expected hours the person is available for contact
Voice Tel. - contact voice area code and phone number
FAX Tel. - contact fax area code and phone number
Address Type - type of the person's address. [Mailing or Physical]
Location Type - type of the person's location. [Residence, Business]
Street Address - the street number and name, including apartment number
Building Name - the building in which the person works
Room Number - the room number in which the person works
City - the city in which the person lives or works
State/Province - the state in which the person lives or works
Postal Code - the zip code for the person's residence or business
Country - the country in which the person lives or works
NOAA User ID - NOAA User ID of type Firstname.Middlename.Lastname
Job Title - the person's job title
Employer - the source of a person's salary
Emp. Type - employee type [Federal, Commissioned, Contractor, Function, Associate]
Mgr. User ID - manager's user ID of the form Firstname.Middlename.Lastname
Work Location - the primary business location for this person
Expertise - Field or fields in which the person has specialized training or experience
Routing Code- Employee mail routing code as listed in NOAA Locator
Org. Acronym - The acronym of the organization or agency that this person represents

Authorization
InPort Person's Signature- signature of the InPort Person
Date -date the Person signed this form
Authorizer's Signature- signature of the individual authorizing this form [Director, IT Manager, InPort Data Steward, etc.]
Date -date the authorizer signed this form
Authorizer's Role - role that entitles the signer to authorize this form [Director, IT Manager, InPort Data Steward, etc.]
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Appendix E - InPort FAQs

Q.  How should I show a version number of the data object that I am try-
ing to catalog?

A.  If you have multiple versions of a data set (or any other catalog item 
type), you should make sure that you include the version number 
in the Title and/or Name of the Catalog Item (Item ID tab of the 
CATALOG EDITOR).  This implies that you will still have the previous 
version maintained in your InPort Library and that after publication, 
both versions of the catalog item will be returned in the InPort Search 
Results.  Having the version number in the Title will allow the user 
performing the search to select the most appropriate version.  By creat-
ed a Related Item link between the two versions, anyone reviewing the 
details of one version would be able to drill over to the other version.
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Appendix F - InPort Tutorials

These tutorials are designed to assist InPort users in developing and publishing 
an inventory of his/her organization’s data collections.  Completing an initial, 
high-level inventory of all data collections within an organization will allow 
organization directors, data managers, and scientists to begin assessing their data 
resource needs, recognize data gaps and/or redundancies, and encourage data 
re-use where possible.

A high-level data inventory should include the cataloging of all data projects and 
data sets.  Details about the who, when, and where of the data and how of access-
ing the data are the minimum detailed information that is necessary to analyze 
the data inventory.  See Appendix G for a listing of required FIS Data Inventory 
fields.

There is a greater range of detail that can be documented using the InPort tools; 
however, it is recommended that organizations begin with this level of detail and  
subsequently add more detail as the information is gathered.

Librarian Tutorial

Introduction

This tutorial is designed to show how an InPort Librarian can set up his/her 
organization’s InPort metadata Library.  It is assumed that the InPort Admin-
istrator has already initialized the Organization and Library and registered the 
organization’s Data Steward and Librarian (at least one each), assigned their In-
Port User Roles and InPort accounts, and given the Librarian his/her password.

An InPort metadata Library is organized in a hierarchy or tree structure, which 
is determined by the child/parent relationship existing among all current catalog 
items. A child item can have only a single parent catalog item, but a parent item 
may have many child items.  The Library object at the top or root of the tree.  In-
Port Librarians create metadata project folders - as the main branches - directly 
below the Library.  Just as real libraries have rooms, shelves, map-cases, and cabi-
nets that contain their collections, InPort Libraries use catalog item type Project 
to be the containers or folders for information about data collections.  Actual 
data collection projects can be organized under the various metadata Project 
folders in a way that best represents how those data collections are managed 
within the organization.  It is important to note that InPort does not require that 
all Libraries be organized in the same way.

InPort is designed to allow data managers to document their data collections in a 
manner that is suitable to the organization’s data management structure.  A data 
management area typically has a data manager and frequently many separate 
data collections.   One possible way to set up an InPort Library is to create a 



metadata Project folder for each data management area in the organization.  
The InPort Librarian can then create and assign InPort User Roles for the data 
managers in their respective InPort Projects.  (See Library Options section below 
for other available functions).

An InPort Librarian uses three tools to set up an InPort Library:

1.	 Library Manager - to create, edit, move InPort Persons
2.	 User Roles Manager - to request, authorize or reject, deactivate 

or reactivate InPort Roles
3.	 User Manager - to create, lock, or unlock InPort database users

A fourth tool, the Catalog Editor, is used to create the Project folder which will 
hold the organization’s metadata.

Note that throughout the tutorials, the Librarian may substitute the names of 
real people, organizations, libraries and real data associated with them in order 
to actually set up his/her Library.  However, if the Librarian chooses to follow 
this tutorial as a training exercise, please prefix all titles, person last-names, and 
e-mail addresses with the user’s initials (or some similar technique) in order to 
create unique organizations (title must be unique) and persons (e-mail address 
must be unique and user account name must be unique).

Only required field items are shown here.  The user may, of course, choose to com-
plete any other field items that are available on the presented tab screens. 

For clarity, example field values are provided in brackets [like this].   Note, 
however, that some fields must be unique in the system (e.g., person’s e-mail ad-
dress and Library title), so the example data is not to be used.

Librarian Core Functions
1.	 Create Project portfolios (based on Data Management areas) 

to hold the metadata 
2.	 Obtain User Role authorizations from a Metadata Steward for 

new Publishers, Authors, and Readers
3.	 Create InPort Persons
4.	 Create sub-organizations (optional)
5.	 Create InPort User Roles requests
6.	 Create InPort database User Accounts
7.	 Authorize or Reject User Role requests
8.	 Deactivate (or reactivate) InPort User Roles
9.	 Organize the InPort metadata Library in a coherent manner
10.	 Monitor InPort usage and completeness

Librarian Sets Up a Metadata Project Portfolio

This tutorial shows an example of how an InPort Librarian can set up an InPort 
Metadata Project Portfolio and create and assign users to create, edit, and pub-
lish metadata in that project.  Each Metadata Project Portfolio should represent 
a specific data management area (group or division) in the organization.

For this example assume that the Librarian has a list of people within his/her 
organization that either will be entering or approving metadata or will be listed 
as having support roles for InPort Catalog Items.  The Librarian will need to 
have those people fill out InPort Person Registration forms and for those that 
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require InPort User Roles, forward them to the organization’s Data Steward for 
signed authorization.  

While waiting for the authorizations, the Librarian can create the metadata 
project portfolio(s), register the new Persons, and create the InPort User Role 
requests.  As the InPort Data Steward returns the signed authorizations, the 
Librarian can create the Person’s InPort User Account and Authorize the role 
request. Note that while the Data Steward is the actual Authorizer, it is the 
Librarian who processes that Authorization.

Librarian Logs into InPort

Access the InPort web site at http://iastrn.nmfs.hawaii.edu/inport/	 The 
InPort home web page appears.

1.	 Click login in the upper right-hand corner of the screen.	
The Login to InPort page appears.				  

2.	 Log in as a user having the Inport Librarian role and insert a 
correct password. Click the Login link.  The InPort Publishing 
page appears.

3.	 At the InPort Publishing page, click the InPort Catalog Tools 
link. Please be patient while the next screen appears.  A teal-
colored login screen, InPort Catalog Tools, appears.		

4.	 When the InPort Catalog Tools Login form appears, enter your 
username and password again.  Click the Logon button.  The 
InPort Catalog Tools screen appears with several choices.

5.	 Clicking on one of the tool buttons will hide the Tools screen 
and open the selected application.  Exiting the application will 
return the user to the Catalog Tools screen where the user can 
choose another application without having to login again.

Librarian Creates Metadata Projects

Using the CATALOG EDITOR tool, the Librarian will create two projects under 
his/her InPort Library.  The Librarian will use these projects to demonstrate the 
functionality of InPort User Roles and catalog hierarchy development.

1.	 In the CATALOG EDITOR, highlight the organization’s InPort 
Library in the navigator tree, right-click and select the Add 
Child Item command.  A blank Item ID tab should appear on the 
Editor pane on right-hand side of the screen

2.	 In the Item ID tab, select Catalog Item Type Project from the 
pop-list.  Enter the Title [MyOrg Fisheries Dependent 
Metadata Portfolio].  Click Save to ensure the record 
is saved.  An abbreviated Project record is saved and the title 
appears in the navigator tree under the Library. 

3.	 Repeat steps 1-2 to create 	Catalog Item Type Project with 
Title [MyOrg Fisheries Independent Metadata 
Portfolio].

4.	 Exit the CATALOG EDITOR



InPort Librarian Creates InPort Persons

Using the LIBRARY MANAGER tool, the Librarian creates users - InPort 
Persons - that are required either for InPort User Roles (e.g., Author, Publisher, 
Reader) or for Catalog Support Roles (e.g., Point-of-Contact, Data Manager, 
Developer).		

1.	 Complete an InPort User Registration form for each user for 
the specified role.  Person who will serve only in catalog item 
Support Roles do not require a signature.

2.	 In the LIBRARY MANAGER, highlight the Organization in the 
navigator tree and right-click to select the New Person com-
mand from the menu.

3.	 Create a person to serve as an InPort Author.  In the Editor 
pane, enter the following information for the new person:  
(1) Last Name [Mypers]; (2) First Name  Myauth; (3) Email 
Address  [Myauth.Mypers@mytest.tst]

4.	 Click Save to save the record.  Status bar displays Transac-
tion complete message indicating the record was saved.  The 
person’s name appears in the navigation tree.

5.	 Create a person to serve as an InPort Publisher. Complete 
Steps 1-4 for another person with information: (1) Last 
Name [Mypers]; (2) First Name  [Mypub]; (3) Email Address  
[Mypub.Mypers@mytest.tst] 

6.	 Create a person to serve in an InPort Support Role. Complete 
Steps 1-4 for another person with information: (1) Last Name 
[Mypers]; (2) First Name  [Mysupp]; (3) Email Address  
[Mysupp.Mypers@mytest.tst]

InPort Librarian Creates InPort User Role Requests

Using the CATALOG EDITOR tool, the Librarian creates InPort User Role 
requests for a specific Catalog Project within the Library.  This step can be done 
prior to signatures authorizing or rejecting the User Role request.  Note that the 
USER ROLE MANAGER can also be accessed via the LIBRARY MANAGER by se-
lecting a Person, however, in the context of setting up Roles for specific Library 
Projects, it makes logical sense to do this step from the CATALOG EDITOR.

1.	 In the CATALOG EDITOR, highlight the Project  [MyOrg 
Fisheries Dependent Metadata Portfoli]

2.	 Select the Project tab in the Editor pane
3.	 Click on the User Roles button
4.	 The CATALOG EDITOR tool will be replaced by the USER 

ROLE MANAGER tool.  The project selected in the CATALOG 
EDITOR will be the highlighted item in the Navigator pane.

5.	 Immediately below the highlighted project, click on ROLE Au-
thor.  Click on the New Request button or right-click and select 
the New Request command from the menu

6.	 The Catalog Role field and Request Date will automatically 
be filled.  Following the Tip Text at the bottom of the screen, 
select the person requesting to be an InPort Author from the 
InPort User pop-list and the Expected Authorizer from that 
pop-list.  Enter Request Notes if desired.

7.	 Click Save to save the request and re-enable the Navigator 
pane.
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8.	 Repeat Steps 5-7 for a Publisher.

InPort Librarian Creates  InPort User Accounts

Once the InPort Library Data Steward signs the authorization for an InPort 
User Role, the Librarian may create an InPort User Account.  As these au-
thorizations may be received individually, it makes sense to access the USER 
MANAGER tool via the LIBRARY MANAGER, however, this tool is also available 
via the INPORT ROLE MANAGER so the Librarian could choose to create the 
InPort User Accounts during the authorization process.  Note that an InPort 
Role request may not be authorized until the Person has an InPort User Ac-
count.

1.	 In the LIBRARY MANAGER, locate and highlight the Person 
[Mypers, Myauth] in the Navigation pane

2.	 Click the InPort User Roles tab to display the Person’s Role 
information. 

3.	 Click the User Mgmt. button near bottom of screen; the InPort 
USER MANAGER screen appears

4.	 Enter Username  [AUTH_MYPERS] and Password and match-
ing Confirm Password values (Librarian’s choice - users will be 
able to change their passwords via the InPort web site).   Click 
the Create button; click Yes in the confirmation box and OK  to 
acknowledge operation success

5.	 Click the Exit button to return to the LIBRARY MANAGER
6.	 Repeat Steps 1-5 for [Mypers, Mypub] (username [PUB_

MYPERS])	

InPort Librarian authorizes (or rejects) User Roles
1.	 In the LIBRARY MANAGER, locate and highlight the Person 

[Mypers, Myauth] in the Navigation pane
2.	 Click the InPort User Roles tab to display the Person’s Role 

information
3.	 Select the Person’s Pending request and then click the Edit/

View Role button
4.	 The USER ROLE MANAGER should open and have the 

Person’s role request record selected
5.	 Select the Data Steward that has authorized the request from 

the Auth/Rej By list.  This will lock the Navigator pane until the 
authorization is saved or cancelled

6.	 Click on the Authorize button to complete the role request, or 
click on Cancel to abort the operation.

7.	 Click the Save button to complete the process and re-enable 
the Navigator pane

8.	 Click the Exit button to return to the LIBRARY MANAGER
9.	 Repeat Steps 1-8 for [Mypers, Mypub] (username [PUB_

MYPERS])	

Librarian Catalog Administration Tasks

Besides adding more InPort User and Support Persons, the Librarian may need 
to deactivate previously authorized Roles, update Person information, assign 
InPort Persons to other organizations or even move a Person to another orga-



nization.  Each of those tasks is described in this User Guide (see the Table of 
Instructions for a full list of detailed How To procedures).

InPort Librarians serve not just as managers but also as mentors of metadata.  
Just as traditional librarians monitor the use of their libraries, InPort Librar-
ians need to monitor the use and completeness of their InPort Libraries.  InPort 
Librarians are the local experts, not only on the use of InPort, but most impor-
tantly on the gathering and publication of metadata for their organization.

Library Options

InPort Librarians may choose to create sub-organizations which would serve to 
represent their internal organization structure.  Just as people work for a com-
mon top-level organization but are assigned to departments or sub-organiza-
tions, for the most flexibility, it is recommended (but not required) that Librar-
ians register their InPort Persons above any possible sub-organizations they 
choose to create.  Librarians can then create Organization Assignments for any 
InPort Persons to those sub-organizations.  Note that Persons created under 
sub-organizations will require an Organization Assignment to the top-level 
organization - the InPort Organization associated with the InPort Library - in 
order to have those Persons available for InPort User Roles within the Library 
(i.e., availability for User Roles trickles down but not up from where the Person 
record was created).

Author Tutorial
InPort Authors are the primary users of the CATALOG EDITOR tool.  Authors 
enter, review, and correct metadata that is in the Draft workflow state.  Authors 
are able to create child catalog items and be able to edit catalog items while they 
are in Draft workflow state.

Once an Author feels that he/she has completed entry of metadata for a Catalog 
Item, he/she will put that item into the Review/Revise state at which point the 
Author will no longer have edit privileges.  Authors will then request that their 
InPort Publisher review the metadata.

Author Core Functions
1.	 Create Catalog Items
2.	 Edit Catalog Items during the Draft workflow state
3.	 Advance workflow state to Review/Revise

Author Catalogs the Organization’s Data Projects

This tutorial shows a practical example of how an InPort Author can catalog his/
her organization’s data collections under his/her assigned InPort Catalog Meta-
data Project portfolio.  Using catalog item types Project and Data Set, metadata 
authors can produce a timely, high-level data inventory of the organization’s 
data collections.  Additional details on those data collections can be added in 
subsequent passes.  This approach will provide scientists and managers the basic 
information required for data discovery, gap analysis, and resource decision-mak-
ing.  For clarity, example field values are provided in brackets [like this]. 
Field item names that begin with an asterisk, (e.g., *Title) are required items that 
must be entered in order to save the record.
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InPort Author Catalogs a Data Collection Project

Using the CATALOG EDITOR tool, the Author creates a Project under his/her 
InPort Metadata Project portfolio.   Note that a Catalog Item of type Project 
may describe a project, program, task, activity, or set of related items.

1.	 In the CATALOG EDITOR, highlight the catalog item in 
the Navigator pane, [ MyOrg Fisheries-Dependent 
Metadata Portfolio], that will be the parent of the new 
data collection project

2.	 Right-click and select Add Child Item command.  A blank Item ID 
tab should appear on the Editor pane on right-handed side of 
the screen

3.	 In the Item ID tab, select Project from the *Catalog Item 
Type pop-list

4.	 Enter a Name [FW Observer].  Note that Name is optional 
and may be the same or different from the Title.  Many infor-
mation items have a long name like a Title and a short com-
mon Name

5.	 Enter the formal *Title [Far West Observer Data 
System] of this project

6.	 Select a Status [In Work] from the list
7.	 Enter an Abstract that describes the project.  A well written 

abstract is an important tool in metadata discovery as it is one 
of the primary fields used in the InPort Search.  The abstract 
should clearly reference the specific subject and unique 
dimensions of the resource being documented.  As with other 
text fields in InPort, the user can cut/paste information from a 
text document (e.g., MS Word), into the field.  The user can also 
bring up the editor box on this or any other text field by typ-
ing Ctrl-E after the cursor is clicked in the text field

8.	 Enter the Purpose or intent of this project.  Is the project in 
support of research or legislation?

9.	 Enter any supplementary information and notes in the Suppl. 
Info/Notes field.  This field can be used for information that 
does not easily fit elsewhere in the InPort model

10.	 Enter any Theme Keywords [observer, longline, 
fishery dependent data].  Separate keywords or key-
word phrases by commas

11.	 Enter any Place Keywords [Pacific Ocean, American 
Samoa]

12.	 Enter any Temporal Keywords [continuous]
13.	 Enter any Stratum Keywords [oceanic, pelagic]
14.	 In the Catalog Item Physical Location area, select an Organiza-

tion or Building from the Organization list.  After selecting 
and organization, the City, State/Province and Country fields 
will be populated if those items are available.  The user may 
choose to edit those fields if desired

15.	 Enter a Location Description if that is necessary [Observer 
Room]

16.	 Click on the Project tab to display the Project Details.  Changing 
tabs in the Catalog Editor will cause an automatic save of any 
changes.  Of course, the user may click the Save button at any 
time in creating or editing



17.	 On the Project tab, select or type in a Project Type [Data 
Collection]

18.	 For data collections, complete the following steps
19.	 Check the Mandated check box if this project was required by 

law or other regulation, and if so, enter the mandating legisla-
tion or regulation in the By field [MSA]

20.	 Select a Collection Type from the list [Observer]
21.	 Select a Collection Authority from the list [Federal]
22.	 Select or enter the Collection Method(s) used to collect the 

data in this Project [Electronic, Paper]
23.	 Click Save to ensure the record is saved
24.	 Exit the CATALOG EDITOR or continue with the tutorial

InPort Author Catalogs a Data Set

Using the CATALOG EDITOR tool, the Author creates a Data Set under the 
data Project that manages that data set.   Note that a Catalog Item of type Data 
Set may describe a database, a collection of related data files or some other user 
defined collection.

1.	 In the CATALOG EDITOR, highlight the catalog item in the 
Navigator pane, [ Far West Observer Data System], 
that will be the parent of the new data set

2.	 Right-click and select Add Child Item command.  A blank Item ID 
tab should appear on the Editor pane on right-hand side of the 
screen

3.	 In the Item ID tab, select Data Set from the *Catalog Item 
Type pop-list

4.	 Enter a Name [FWODS Database].  Note that Name is op-
tional and may be the same or different from the Title.  Many 
information items have a long name like a Title and a short 
common Name

5.	 Enter the formal *Title [Far West Observer Database] 
of this project

6.	 Select a Status [In Work] from the list
7.	 Enter an Abstract that describes the project.  A well written 

abstract is an important tool in metadata discovery as it is one 
of the primary fields used in the InPort Search.  The abstract 
should clearly reference the specific subject and unique 
dimensions of the resource being documented.  As with other 
text fields in InPort, the user can cut/paste information from a 
text document (e.g., MS Word), into the field.  The user can also 
bring up the editor box on this or any other text field by typ-
ing Ctrl-E after the cursor is clicked in the text field

8.	 Enter the Purpose or intent of this data set.   This field is op-
tional and may or may not be identical to the parent catalog 
item’s purpose

9.	 Enter any supplementary information and notes in the Suppl. 
Info/Notes field.  This field can be used for information that 
does not easily fit elsewhere in the InPort model

10.	 Enter any Theme Keywords [observer, longline, 
fishery dependent].  Separate keywords or keyword 
phrases by commas

11.	 Enter any Place Keywords [Pacific Ocean, American 
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Samoa]
12.	 Enter any Temporal Keywords [continuous]
13.	 Enter any Stratum Keywords [oceanic, pelagic]
14.	 In the Catalog Item Physical Location area, select an Organiza-

tion or Building from the Organization list.  After selecting 
and organization, the City, State/Province and Country fields 
will be populated if those items are available.  The user may 
choose to edit those fields if desired.  Optionally, if the physical 
location is the same as the parent catalog item, click on the X 
button

15.	 Enter a Location Description if that is necessary [FW IT 
Room]

16.	 Click on the Data Set tab to display the Data Set Details.  
Changing tabs in the Catalog Editor will cause an automatic 
save of any changes.  Of course, the user may click the Save 
button at any time

17.	 On the Data Set tab, select or type in a Data Set Type 
[Database]

18.	 Select a Data Set Maintenance Frequency from the list.  This 
describes the frequency with which changes and additions 
are made to the data set (e.g., Continuous, Weekly, Quarterly) 
[Continuous]

19.	 Enter a Data Set Entity - Attribute Overview.  This should de-
scribe the different kinds of information contained in the data 
set, in summary form

20.	 If there is a publication or reference that provides a complete 
description of the entities, including column names and 
formats, enter a Data Set Entity - Attribute Detailed Citation.  
This document may also be cataloged more fully as a child 
Document of this Data Set

21.	 If there is a link or URL to the above reference, end it in the At-
tribute Detailed Citation URL.  This URL may also be described 
using the URL Details Module

22.	 A Source Media Type may be defined, if appropriate
23.	 Click Save to ensure the record is saved
24.	 Exit the CATALOG EDITOR or continue with the tutorial

InPort Author Catalogs a Document

InPort provides a convenient way for users to organize and describe their docu-
ments that are related to their data collections.  All InPort catalog item types can 
have child Documents.  Users may wish to create InPort Project folders - much 
like a file system - under which they can catalog like documents (e.g., create 
an InPort Project titled [Observer Quarterly Reports] that is itself a 
child item of their [Observer Data System].  The user could then describe 
the Set of... quarterly reports and catalog each as child items under that Project 
folder.  This method would allow the user to have multiple document folders 
where each document folder can be fully described.

Using the CATALOG EDITOR tool, the Author creates a Document under the 
data set. 

1.	 In the CATALOG EDITOR, highlight the catalog item in the 
Navigator pane, [ Far West Observer Data System], 



that will be the parent of the new document
2.	 Right-click and select Add Child Item command.  A blank Item ID 

tab should appear on the Editor pane on right-hand side of the 
screen

3.	 In the Item ID tab, select Document from the *Catalog Item 
Type pop-list

4.	 Enter a Name [FWODS_2005_annual.doc].  Note that 
Name is optional and may be the same or different from the 
Title.  This example shows the use of the actual name of the 
physical document.

5.	 Enter the formal *Title [Far Western Observer 2005 
Annual Report] of this document

6.	 Select a Status [Completed] from the list
7.	 Enter an Abstract that describes the document.  A well written 

abstract is an important tool in metadata discovery as it is one 
of the primary fields used in the InPort Search.  The abstract 
should clearly reference the specific subject and unique 
dimensions of the resource being documented.  As with other 
text fields in InPort, the user can cut/paste information from a 
text document (e.g., MS Word), into the field.  The user can also 
bring up the editor box on this or any other text field by typ-
ing Ctrl-E after the cursor is clicked in the text field

8.	 Enter the Purpose or intent of this document.   This field is op-
tional and may or may not be identical to the parent catalog 
item’s purpose

9.	 Enter any supplementary information and notes in the Suppl. 
Info/Notes field.  This field can be used for information that 
does not easily fit elsewhere in the InPort model

10.	 Enter any Theme Keywords [observer, longline, 
fishery dependent].  Separate keywords or keyword 
phrases by commas

11.	 Enter any Place Keywords [Pacific Ocean, American 
Samoa]

12.	 Enter any Temporal Keywords [continuous]
13.	 Enter any Stratum Keywords [oceanic, pelagic]
14.	 In the Catalog Item Physical Location area, select an Organiza-

tion or Building from the Organization list.  After selecting 
and organization, the City, State/Province and Country fields 
will be populated if those items are available.  The user may 
choose to edit those fields if desired

15.	 Enter a Location Description if that is necessary [FW IT 
Room]

16.	 Click on the Document tab to display the Document Details.  
Changing tabs in the Catalog Editor will cause an automatic 
save of any changes.  Of course, the user may click the Save 
button at any time in creating or editing

17.	 On the Document tab, select or type in a Publication Date 
[30-JAN-2005]

18.	 Select a document Type [Reference]
19.	 Select a document Format [Microsoft Word]
20.	 Enter a Format Version [MS-Office Word 2003]
21.	 Select a Document Status [In Review]
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Author Adds Details to Catalog Items

Using the CATALOG EDITOR tool, the Author adds more detailed information 
to the data collection project.

InPort Author Adds URLs to a Data Collection Project

Adding URLs to catalog items will make it easy for InPort searchers to drill over 
to web sites that support the project or item being documented.

1.	 In the CATALOG EDITOR, highlight the catalog item in the 
Navigator pane, [ Far West Observer Program]

2.	 Click on the URLs tab
3.	 Enter a *URL [http://fwpfsc.noaa.gov/ll_obs].  

Note that it is good form to validate the URL with a browser 
and then copy/paste it into the URL field

4.	 Enter a Description of the URL [Web site describing 
the FWOP and providing access to FWOP 
documentation and resources] 

5.	 Click Save to ensure the record is saved

InPort Author Adds Time Frames to a Data Collection Project

Time Frame information is important for both data discovery and for recog-
nizing data gaps should they occur. Time Frame information may be a discrete 
event time, a start time, a range of times (begin and end time), or some alterna-
tive of time (e.g., beginning and ending Trip Number) that defines the temporal 
bounds of the catalog item.  Multiple time frame definitions may be defined and 
descriptions can be added for clarification.

1.	 In the CATALOG EDITOR, highlight the catalog item in the 
Navigator pane, [Far West Observer Program]

2.	 Click on the Time Frames tab
3.	 Enter a Start Time [01-JAN-1994 12:20] and End Time 

[30-APR-2002 15:25]
4.	 Select the Time Type [Range]
5.	 Enter an Alternate Start as of Info [Trip No. 1] and an 

Alternate End as of Info [Trip No. 243]
6.	 Enter a Description of the new time frame [Date entry 

into rBASE system]
7.	 Create a second Time Frame record with only a Start 

Time [01-MAY-2003 08:15] and select Time Type 
[Continuous]

8.	 Enter a Description of the new time frame [Date entry 
into Oracle]

9.	 Click Save to ensure the record is saved

InPort Author Adds Geographic Area Details to a Project

The Geographic Area or bounds of the data collection can be described by both 
latitude and longitude boundaries and by a Geographic Area Description.  Like 
Time Frames, Geographic Area information is important for data discovery and 
for recognizing data gaps should they occur.  Longitude and latitude are speci-
fied in decimal degrees with north latitudes positive and south negative, east 



longitude positive and west negative.

1.	 In the CATALOG EDITOR, highlight the catalog item in the 
Navigator pane, [Far West Observer Program]

2.	 Click on the Geographic Area tab
3.	 Enter a E Bound (eastern boundary) longitude [150.5]
4.	 Enter a W Bound (western boundary) longitude [-160.33]
5.	 Enter a N Bound (northern boundary) latitude [30]
6.	 Enter a S Bound (southern boundary) latitude [-30]
7.	 Enter a Geographic Area Description [Rectangular area 

around American Samoa]
8.	 Click Save to ensure the record is saved

InPort Author Adds Support Roles to a Project

Many people serve support roles for data collections.  Data Stewards, Database 
Developers, Data Managers, Points-of-Contact, etc., all contribute to the under-
standing, maintenance, and access of the data.  At a very minimum, every catalog 
item should have a Point-of-Contact support role listed.

1.	 In the CATALOG EDITOR, highlight the catalog item in the 
Navigator pane, [Far West Observer Program]

2.	 Click on the Support Roles tab
3.	 Select a *Support Role type from the list [Point of 

Contact]
4.	 Enter the date the role became effective in *Date Effective From 

[01-JAN-1994 00:00]
5.	 Enter the date the role ended in Date Effective To [15-APR-

2002 00:00]
6.	 Select a registered InPort Person from the Person list 

[Michener, James]
7.	 Note that selecting a Person will automatically populate the 

Person’s Organization name
8.	 Enter any Contact Instructions that clarify how best to contact 

the person in the support role [email or work phone 
during business hours]

9.	 Click Save to ensure the record is saved

InPort Author Adds Data Access Details to a Data Set

Data Access details will provide information about the methods and constraints 
of accessing the data represented by the catalog item.  Every data set cataloged in 
InPort should have details on the security/confidentiality of the data and specify 
any restrictions on who can or cannot access the data in question.

1.	 In the CATALOG EDITOR, highlight the catalog item in the 
Navigator pane, [Far West Observer Data Set]

2.	 Click on the Access tab
3.	 Select a *Security Class from the list [Confidential]
4.	 Enter the Access Constraints.  There are restrictions and legal 

prerequisites for accessing the data set, including any access con-
straints applied to assure privacy or intellectual property and any 
restrictions on the use of the data. [Contact FWPFSC Data 
Manager for details (999) 123-4567. Data 
must be binned in 5 degree squares and meet 
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a 3 boat minimum]
5.	 Other detail fields are available for documenting the Access and 

Security of the data and may be completed, however, the above 
two fields are the minimum required for data inventory

6.	 Click Save to ensure the record is saved

Author Completes Initial Metadata Entry

Once an InPort Author completes a catalog item (or a convenient set of catalog 
items), it is time to change the catalog item Workflow State to Review/Revise 
from the initial Draft state.  An Author will not be able to make any changes to 
catalog items that are not in Draft though, if necessary, the InPort Publisher may 
revert the catalog item back to Draft for further editing by the Author.  Chang-
ing the item to Review/Revise is an indication that the item is ready for review 
by the Publisher for potential approval and publication

InPort Author Changes Workflow Status

Using the CATALOG EDITOR tool, the Author changes the catalog item’s work-
flow state to Review/Revise.  In many cases, the user may choose to propagate 
the workflow state change down to all the selected item’s children.  Refer to 
Chapter 5 - Catalog Publishing for complete details.  For this example, the se-
lected catalog item and its child catalog items will change from Draft to Review/
Revise.

1.	 In the CATALOG EDITOR, highlight the catalog item in the 
Navigator pane, [Far West Observer Project]

2.	 In the top menu bar choose the Reports>Hierarchy Report com-
mand to show the names and states of all child items

3.	 In the CATALOG EDITOR tool, click on the Catalog Details tab
4.	 Select Review/Revise from the Metadata Workflow State list
5.	 Answer Yes to Do you want to update any child items?
6.	 In the top menu bar choose the Reports>Hierarchy Report com-

mand to show the names and states of all child items and 
confirm that child item workflow states were changed

7.	 The Author should notify his/her InPort Publisher that the 
catalog items are ready for review.

Publisher Tutorial
InPort Publishers are responsible for reviewing, correcting, publishing and/or 
withdrawing catalog items.

Publisher Core Functions
1.	 Review metadata for completeness and accuracy
2.	 Approve Catalog Item metadata
3.	 Publish Catalog Items
4.	 When necessary, withdraw Catalog Items from publication
5.	 If necessary, place Catalog Items back in Draft state so that an 

InPort Author may complete/correct metadata



Publisher Manages Catalog Item Publication

InPort Publishers are responsible for ensuring that all published metadata is, to 
the best of their knowledge, accurate, objective, and complete.

InPort Publisher Reviews and Approves Catalog Items

Using the CATALOG EDITOR tool, the Publisher reviews and, if necessary, makes 
corrections/additions to metadata for catalog items.  To ensure that each and ev-
ery catalog item is reviewed individually, a Publisher must Approve catalog items 
on an item by item basis.  After confirming the completeness and accuracy of the 
metadata for a catalog item, the Publisher changes the catalog item’s workflow 
state from Review/Revise to Approved.

1.	 In the CATALOG EDITOR, highlight the catalog item in the 
Navigator pane, [Far West Observer Project]

2.	 Publisher reviews the catalog item metadata and confirms 
that it is complete and accurate

3.	 In the top menu bar choose the Reports>Hierarchy Report com-
mand to show the names and states of all child items

4.	 In the CATALOG EDITOR tool, click on the Catalog Details tab
5.	 Select Approved from the Metadata Workflow State list
6.	 Repeat steps 1-4 for each completed catalog item
7.	 In the top menu bar choose the Reports>Hierarchy Report com-

mand to show the names and states of all child items and 
confirm that child item workflow states were changed

InPort Publisher Publishes Catalog Items

Using the CATALOG EDITOR tool, the Publisher can publish (internally or 
externally) any catalog items that are currently in Approved workflow state.  Note 
that InPort Authors may still be creating and editing child catalog items of these 
ready-to-be-published items.  Only items that are currently Approved will be 
available for publication.

1.	 In the CATALOG EDITOR, highlight the catalog item in the 
Navigator pane, [Far West Observer Project]

2.	 In the top menu bar choose the Reports>Hierarchy Report com-
mand to show the names and states of all child items

3.	 In the CATALOG EDITOR tool, click on the Catalog Details tab
4.	 Select Published-External from the Metadata Workflow State 

list
5.	 Answer Yes to Do you want to update any child items?
6.	 In the top menu bar choose the Reports>Hierarchy Report com-

mand to show the names and states of all child items and 
confirm that child item workflow states were changed

7.	 Within a few minutes, the newly published catalog items 
should appear in any appropriate InPort Search via the InPort 
web site.  If the Publisher had chosen to Publish-Internal, 
InPort users would need to log into the InPort web site before 
searching for the new items.
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Appendix G- FIS Data Inventory

FIS Data Inventory  - Mandatory Elements by Catalog Item Type

 
The FIS Fisheries-Dependent Data* Inventory is to be completed by each fisheries office / fisheries partner using the web-based InPort 
Metadata Catalog (see below for website). This inventory is the first phase of metadata data entry. For each catalog item type, the 
required data fields are listed. The required data fields answer the who, what, when and where questions about the data. Note, however, 
that the only mandatory catalog item type is Data Set; Projects should be used to help organize the Data Sets; and Documents, Data 
Entities and Procedures are optional in this first phase. As time and funds permit, other data sets (i.e., fisheries-independent data) and 
more in-depth metadata (for example, table and column descriptions) can be entered.  
 
Documenting fisheries data is an ongoing process, and it is expected that entering metadata into InPort will be a continuous activity.  
 
InPort Website: https://ias.pifsc.noaa.gov/inport/ 
 
* A definition of "fisheries-dependent" is given at the bottom of this table

Catalog Item Type Data Entry Item What to Enter Detailed Description

Project (optional)

Catalog Item Type Select "Project" from pull-
down list

Title Title of the project The title of the Project should be as descriptive as possible, 
employing terms that clearly identify the specific subject and 
unique contents of the project. This field will be included in 
InPort website searches.

Abstract Detailed description of the 
project

The abstract should clearly reference the specific subject 
and unique dimensions of the Project being documented, 
along with explicit consideration of major scientific concepts, 
keywords, and other descriptive terms to aid system users in 
searching through other InPort Catalog Items and identify-
ing relevant ones. This field will be included in InPort website 
searches.

Keywords Include Theme keywords, 
Place keywords, Temporal 
keywords and Stratum 
keywords 

Consult InPort Catalog Editor Help for further details. These 
fields will be included in InPort website searches.

URL Location of the document 
on the web (if available)

Online (internet) references to the Project. Give the exact 
URL to online references for this project.

Time Frame Start Time or Range of 
Dates

The date when the Project began or the date range in which 
the Project occurred
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Geographic Area Geographic Bounds or 
Geographic Area Descrip-
tion

Enter the geographic bounds (N, S, E, W) in decimal degrees 
to the precision available; format: real numbers; for lati-
tude, numbers may range from -90.0 to 90.0; for longitude, 
numbers may range from -180.0 to 180.0. For data sets that 
include a complete band of latitude around the earth, the East 
Bounding Coordinate should be assigned the value 180.0; 
the West Bounding Coordinate should be assigned the value 
-180.0

Support Role Point of Contact (Person 
or Organization), Date 
Effective

List the person or persons who can provide further informa-
tion about this project. List the date (DD-MON-YYYY 
format) this person’s role became effective.

Catalog Item Type Data Entry Item What to Enter Detailed Description

Data Set (required)

Catalog Item Type Select "Data Set" from 
pulldown list

Title Phrase describing the data 
set

The title of the data set should be as descriptive as possible, 
employing terms that clearly identify the specific subject 
and unique contents of the data set. Include geographic or 
regional identifiers to distinguish, say, Hawaii logbook data 
from SW logbook data. This field will be included in InPort 
website searches.

Abstract Detailed description of the 
data set

The abstract should clearly reference the specific subject and 
unique dimensions of the Data Set, along with explicit con-
sideration of major scientific concepts, keywords, and other 
descriptive terms to aid system users in searching through 
other InPort Catalog Items and identifying relevant ones. This 
field will be included in InPort website searches.

Keywords Include Theme keywords, 
Place keywords, Temporal 
keywords and Stratum 
keywords 

Consult InPort Catalog Editor Help for further details. These 
fields will be included in InPort website searches.

URL Location of the data on the 
web (if available)

Online (internet) references to the Data Set. Give the exact 
URL to online references for this data set.

Time Frame Start Time or Range of 
Dates

The date (DD-MON-YYYY format) when the Data Set 
began to be collected or the date range in which the data was 
collected

Geographic Area Geographic Bounds or 
Geographic Area Descrip-
tion

Enter the geographic bounds (N, S, E, W) in decimal degrees 
to the precision available; format: real numbers; for lati-
tude, numbers may range from -90.0 to 90.0; for longitude, 
numbers may range from -180.0 to 180.0. For data sets that 
include a complete band of latitude around the earth, the East 
Bounding Coordinate should be assigned the value 180.0; 
the West Bounding Coordinate should be assigned the value 
-180.0
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Support Role Point of Contact (Person 
or Organization), Date 
Effective

List the person or persons who can provide further informa-
tion about this Data Set. List the date (DD-MON-YYYY 
format) this person’s role became effective

Data Set Type Select "Mixed", "Flat files", 
"Database" or "Other" 
from pulldown list or enter 
a new type

Maintenance 
Frequency

Select from choices in 
pulldown list

How often is the data updated? Select from: Continuously, 
Daily, Weekly, Monthly, Quarterly, Yearly, As Needed, Irregu-
larly, Unknown, None Planned

Entity Attribute 
Overview

Detailed description of the 
components of the data set

Describe the data set you are documenting. For this inventory, 
it is not necessary to list tables and column descriptions unless 
time and funds allow

Catalog Item Type Data Entry Item What to Enter Detailed Description

Document (op-
tional)

Catalog Item Type Select "Document" from 
pulldown list

Title Title of the document The title of the Document should be as descriptive as possible, 
employing terms that clearly identify the specific subject and 
unique contents of the document. This field will be included 
in InPort website searches.

Abstract Detailed description of the 
document

The abstract should clearly reference the specific subject and 
unique dimensions of the Document, along with explicit con-
sideration of major scientific concepts, keywords, and other 
descriptive terms to aid system users in searching through 
other InPort Catalog Items and identifying relevant ones. This 
field will be included in InPort website searches.

Keywords Include Theme keywords, 
Place keywords, Temporal 
keywords and Stratum 
keywords

Consult InPort Catalog Editor Help for further details. These 
fields will be included in InPort website searches.

URL Location of the data on the 
web (if available)

Online (internet) references to the Document. Give the exact 
URL to online references for this document.

Time Frame Not required for docu-
ments; use Publication 
Date below instead
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Geographic Area Geographic Bounds or 
Geographic Area Descrip-
tion

Enter the geographic bounds (N, S, E, W) in decimal degrees 
to the precision available; format: real numbers; for lati-
tude, numbers may range from -90.0 to 90.0; for longitude, 
numbers may range from -180.0 to 180.0. For data sets that 
include a complete band of latitude around the earth, the East 
Bounding Coordinate should be assigned the value 180.0; 
the West Bounding Coordinate should be assigned the value 
-180.0

Support Role Point of Contact (Person 
or Organization), Date 
Effective

List the person or persons who can provide further informa-
tion about this document. List the date (DD-MON-YYYY 
format) this person’s role became effective

Publication Date Date the document was 
published

Catalog Item Type Data Entry Item What to Enter Detailed Description

Data Entity (op-
tional)

This catalog item type is not required for the FIS Data Inven-
tory

Procedures (op-
tional)

This catalog item type is not required for the FIS Data Inven-
tory

Definitions of Fisheries-Independent and Fisheries-Dependent Data

There are two types of fisheries data collected by NMFS: fishery-independent and fishery-dependent data. Fishery-independent data 
are obtained by NOAA through surveys and research conducted by federal, state, and university scientists; these data are collected 
“independent” of fishing activities and use scientific sampling methods. Fishery-dependent data are gathered from both commercial 
and recreational fishermen and processors through log books, trip tickets and landing bills. They are also collected by state and federal 
agencies (or their contractors), through dockside intercepts (for both commercial and recreational fishermen), through telephone sur-
veys that relate to recreational fishing activities (e.g., Marine Recreational Fisheries Statistical Survey), through telephone surveys that 
gather socio-economic information, and through observer programs that provide detailed commercial catch, effort, and bycatch data. 
Fishery-dependent data from recreational fisheries are essential for assessing the mortality and other stresses that result from fishing. 
These data provide a direct measure of the effectiveness of management and regulations.
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